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Preface

This guide describes how to use Oracle Virtual Operator Panel (VOP) to monitor and 
control tape drives.

Audience
This document is intended for VOP system administrators and operators.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
Visit the Oracle Technical Network (OTN) at the following URL to access publications 
for StorageTek libraries, tape drives, and associated software and hardware:

http://docs.oracle.com

Access Oracle ASR related publications at the following URL:

http://www.oracle.com/technetwork/systems/asr/documentation/index.html

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Introduction 

Oracle Virtual Operator Panel (VOP) is a suite of software applications that allow you 
control and monitor the functionality of different tape drives. VOP provides different 
modes of access to specific tape library functions.

VOP applications provide an intuitive and user-friendly graphical user interface (GUI) 
to display drive-related information, to configure the drive, or to perform various 
drive operations.

VOP consists of two main components:

■ VOP client

■ VOP server (SDP2 Service Delivery Platform 2)

The VOP client can be run in standalone mode (directly connected to a specific 
devices) or can be connected to the VOP server to direct all traffic through the server.

The VOP server serves as a single point of access to all devices, and is designed to 
reduce the number of device connections. It provides automated ASR functions and 
allows for additional logs to be collected.

VOP is designed for customers who have an existing Oracle service contract for their 
tape drives and libraries.

VOP includes the following applications:

■ "Multi-Drive Virtual Operator Panel (MD-VOP)"

■ "T10000 9840D VOP"

■ "LTO VOP"

■ "9XXX VOP"

■ VOP Server

Multi-Drive Virtual Operator Panel (MD-VOP)
This application enables you to control and monitor a variety of tape drives in 
multiple libraries. This allows for a standalone or client/server configuration.

MD-VOP supports the following StorageTek libraries:

■ SL8500

■ SL3000

■ SL500

■ SL150
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■ L700/L1400

■ 9310

MD-VOP supports the following tape drives:

■ StorageTek T10000A, T10000B, T10000C, and T10000D

■ StorageTek T9840D

■ HP LTO-4, LTO-5, and LTO-6 (encryption capable)

■ IBM LTO-4, LTO-5, and LTO-6 (encryption capable)

T10000 9840D VOP
This application enables you to control and monitor a single Oracle StorageTek 
T10000A, T10000B, T10000C, T10000D, or T9840D tape drive.

LTO VOP
This application enables you to control and monitor a single encryption-enabled HP or 
IBM Linear Tape Open (LTO) Ultrium LTO-4, LTO-5, or LTO-6 tape drive.

9XXX VOP
This application enables you to control and monitor a single Ethernet-connected 
Oracle StorageTek T9x40 series tape drive.

Note: You can access the single-drive VOP applications within the 
MD-VOP interface, or run them as standalone applications.

VOP Server (SDP2)
This application serves as a single point of access to all devices, and is designed to 
reduce the number of device connections. It provides automated ASR functions and 
allows for additional logs to be collected.

The server can be accessed by multiple GUIs. The GUI enables you to view and control 
your devices. It is also used to set up the server configuration.

The VOP server is installed separately. It is not installed as part of the MD-VOP 
installer.
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2Obtaining VOP 

This chapter describes how to obtain VOP.

Note: VOP includes StorageTek MD-VOP, along with the T10000 
9840D VOP, LTO VOP, and 9XXX VOP single drive applications. You 
can access these applications within the MD-VOP interface, or run 
them as standalone applications.

VOP is available for download from the Oracle Software Delivery Cloud and the My 
Oracle Support page.

Downloading VOP from the Oracle Software Delivery Cloud
To obtain VOP, do the following:

1. Create a local destination folder for the VOP download. If you are using Linux or 
UNIX, create this folder as a direct subordinate to the root (home folder).

2. Launch your web browser and access Oracle's Software Delivery Cloud at the 
following URL:

http://edelivery.oracle.com

3. On the Welcome page, click Sign In/Register.

4. Enter the Username (ID) and Password provided by your Oracle support 
representative and then click Sign In.

5. On the Terms & Restrictions page, read the License Agreement and Export 
Restrictions, and select the check boxes to indicate your acceptance. Then click 
Continue.

6. On the Media Pack Search page, click the Select a Product Pack menu, and select 
Oracle StorageTek Products.

7. Click the Platform menu, and select Generic Platform.

8. Click Go.

9. In the list of available products, select Oracle Virtual Operator Panel and click 
Continue.

10. Click Download and save the media pack .zip file to the destination folder you 
created in Step 1.

Separate VOP installers for Windows, Solaris Sparc, Solaris x86 and Linux86 are 
extracted. You may delete those installers that do not apply.
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Additionally, the zip file includes both the server and client components.

A Readme file is also included. Read this document before installing VOP.

Downloading VOP from My Oracle Support (MOS)
The My Oracle Support (MOS) page includes the officially released version of VOP, 
along with VOP patch releases.

To obtain VOP, do the following:

1. Create a local destination folder for the download. If you are using Linux or UNIX, 
create this folder as a direct subordinate to the root (home folder).

2. Launch your web browser and access the My Oracle support (MOS) page at the 
following URL:

http://myoraclesupport.com

3. Click Sign In.

4. Enter the Username (ID) and Password provided by your Oracle support 
representative and then click Sign In.

5. Click the Patches and Updates tab.

6. Under Product, locate Oracle Virtual Operator Panel.

7. Download the desired version or patch release.
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3Requirements 

This chapter describes VOP pre-installation requirements.

User Roles
VOP is available in two versions, designed for the following customer roles:

■ System Administrator

This version of VOP is designed for the system administrator who configures and 
controls the VOP configuration.

■ Operator

This version of VOP is designed for the operator who monitors the configuration. 
In this version, the operator can only manipulate a single tape drive at one time. 

Each of these versions can be run in either standalone or client/server mode.

System Requirements
This section describes MD-VOP system requirements.

Note: In a client/server configuration, you must install the client and 
server on separate instances of the operating system. You cannot run 
these as the same user.

Client
The VOP client requires the following:

Operating System Requirements
VOP is supported on the following operating systems:

■ Linux Kernel (2.6.18 or later), Redhat 9.0, ES

– Some Linux installations may require you to install additional libraries. 

– The use of VMWARE and additional programs is supported. However, these 
may require you to configure ports and permissions as necessary. 

■ Solaris 10/Solaris 11 (Sparc and x86)

■ Microsoft Windows XP (with Service Pack 3), Windows 7, or Windows 8

The VOP package includes separate installers for each of these operating systems.
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Additional Requirements
The following are required:

■ 2 GHz processor

■ Disk Space: Approximately 40 GB

■ Memory: 4 GB

■ Monitor screen resolution 1024x768 (minimum)

■ Available Ethernet port for static IP addressing

■ RJ45-RJ45 Ethernet cross-over cables (direct connection to a tape drive or drive 
tray)

■ RJ45-RJ45 Ethernet cables (connection through an Ethernet switch)

Server
The VOP server requires the following:

Operating System Requirements
The VOP server is supported on Oracle Linux 6.4 (recommended). It includes a Sun 
Java 32 bit version. The server software will attempt to automatically determine 
whether a Sun Java 64 bit version is available for use.

Note: The server is designed to run without cohosting other 
applications. If you require cohosting with another program, open a 
Request for Enhancement request (RFE).

Additional Requirements
■ 4 core processor (minimum)

■ 8GB RAM (minimum)

■ Disk Space: 100GB

■ Recommended minimum of 3 Ethernet ports (one for outgoing access and 2 for 
incorporating the private network to the devices)

■ RJ45-RJ45 Ethernet cables (connection through an Ethernet switch)

■ Switch for the private network that will support VLAN (required)

■ Layer 2 switch

Note: You may need to increase the server size depending on the 
number and type of devices present.

Java Runtime Environment Requirement
VOP applications are Java-based. During installation, a local copy of the Java Runtime 
Environment (JRE) is placed in the installation directory for exclusive use by the VOP 
applications.

VOP requires JRE version 1.7 or higher. It is recommended that you use the local copy 
of Java included, as the java version can affect the application. 
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Library and Tape Drive Requirements
This section describes MD-VOP library and drive support.

MD-VOP Library Support
MD-VOP supports multiple tape drives at the library level.

The following table lists libraries supported by MD-VOP, along with required 
minimum firmware levels:

Table 3–1  MD-VOP Library Support

Library/Component Minimum Firmware Requirement

SLS8500 FRS 4.70, FRS 4.14, FRS3.98b

SL3000 FRS 2.05, FRS 2.30

SL500 V1373

SL150 2.25

L700/L1400 3.18.02

9310 All

Library Console FRS 4.00

MD-VOP Tape Drive Support
The following table lists tape drives supported by MD-VOP, along with required 
minimum firmware levels:

Table 3–2  MD-VOP Tape Drive Support

Tape Drive Minimum Firmware Requirement

T10000A 1.44.111

T10000B 1.44.211

T10000C 1.51.316

T10000D 408.105

T9840D 1.45.703

HP LTO4* H58S (Fibre Channel)

B57S (SCSI)

IBM LTO4* 94D7

HP LTO 5* I5BS

IBM LTO 5* BBNH/2.36.23

HP LTO 6* Contact Oracle Support for supported list.

IBM LTO 6* Contact Oracle Support for supported list.

VSM 4/5 Contact Oracle Support for latest version.

* LTO encryption-capable tape drives only
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MD-VOP Placeholder Tape Drive Support
You can manually add tape drives to the MD-VOP configuration to provide 
placeholders as an indication that there is a tape drive in a particular slot.

The following table lists supported placeholder tape drives, along with required 
minimum firmware levels:

Note: 9XXX drives are non-reactive. You can obtain logs for these 
drives, however, they do not show loaded/unloaded state.

Table 3–3  MD-VOP Placeholder Tape Drive Requirements

Tape Drive Minimum Firmware Version

T9840B, T9840C, T9940A, 
T9940B

T9840B - 1.44.310

T9840C - 1.45.503

T9940B - 1.44.410

LTO 2/3/4 (non encrypting) 
and T9840A

NA

MD-VOP ASR Capable Drive Support
MD-VOP allows the user to create a service request in My Oracle Support (MOS) and 
automatically transmit logs for Oracle Support review. The following devices are 
supported:

■ Oracle StorageTek SL8500, SL3000, SL500, and SL150 libraries

■ Oracle StorageTek T9x40 and T10000 series tape drives

■ VSM 4/5 (only in client/server mode)

This feature requires a valid service contract. Also, devices must be activated in MOS 
for processing. See "ASR" on page 7-15 for more information about this feature.

T10000 9840D VOP Drive Support
The following table lists tape drives supported by T10000 9840D VOP, along with 
required minimum firmware levels:

Table 3–4  T10000 9840D VOP Tape Drive Support

Tape Drive Minimum Firmware Requirement

T10000A 1.44.111

T10000B 1.44.211

T10000C 1.51.316

T10000D TBD

T9840D 1.45.703

LTO VOP Drive Support
The following table lists tape drives supported by LTO VOP, along with required 
minimum firmware levels:



Table 3–5  LTO VOP Tape Drive Support

Tape Drive Minimum Firmware Requirement

HP LTO 4 H58S (Fibre Channel)

B57S (SCSI)

HP LTO 5 I5BS

HP LTO 6 TBD

IBM LTO 4 94D7

IBM LTO 5 BBNH/2.36.23

IBM LTO 6 TBD

Configuration Considerations

Requirements 3-5

9XXX VOP Drive Support
The following table lists tape drives supported by 9XXX VOP, along with required 
minimum firmware levels:

Table 3–6  9XXX Tape Drive Support

Tape Drive Minimum Firmware Requirement

T9840B, T9840C T9840B - 1.44.310

T9840C - 1.45.503

T9940B - 1.44.410

T9940A, T9940B T9940B - 1.44.410

Configuration Considerations
Review the following additional considerations:

Ethernet Connection to the Drive
To use VOP with a drive, you must have an Ethernet connection from your computer 
to the Ethernet port on the tape drive or drive tray rear panel.

■ For a direct connection to the drive, you must use a single crossover Ethernet 
cable.

■ For an indirect connection (through an Ethernet switch), you must use a straight 
Ethernet cable to connect your computer to the switch. The switch-to-drive cable 
should already be connected.

Service Network
VOP is designed to operate on the service network configured as a private LAN. It 
uses the service network Ethernet port for communications. This port can also be used 
by other applications, such as:

■ Oracle Key Manager (OKM), formerly Key Management System (KMS), used for 
secure encryption of tape drives.

■ Oracle Service Delivery platform (SDP), used for delivery of fast and accurate 
service.
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The private LAN recommendation ensures security from unauthorized access. Refer to 
the Oracle Key Manager Systems Assurance Guide for more information about the service 
network.

Additional Considerations
The following are additional considerations:

■ When configuring the tape drive network, adhere to the guidelines included in 
your tape drive publications. A qualified service representative should implement 
the tape drive network.

■ If MD-VOP is the only program installed, the following are recommended:

– Connect the tape drive Ethernet port on a private network.

– Use static IP addresses, not dynamic addresses.

– Use Level 2 switches to isolate each library (highly recommended)

– Ensure that the latest firmware is loaded on all tape drives.

■ The IP address for a new tape drive defaults to 10.0.0.1. When you configure the 
network and tape drives, be sure to configure one tape drive at a time as you add 
them to the network.

■ MD-VOP configuration requires a unique IP address to be assigned for each tape 
drive.

■ If the configuration environment includes SDP, contact your SDP service 
representative to assist in assigning IP addresses.

■ Though VOP and VOP server can coexist, it is recommended that you do not mix 
these modes in most situations. A limited number of connections to the tape drives 
is permitted.

■ When the VOP server is used, a VLAN is required between the tape drives, 
libraries, and the VSM. The VLAN must reside on a separate IP to the server. This 
should be a private service network to the devices with private ports to the 
devices.

■ The VOP server requires static IP addresses.
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4Installing VOP 

This chapter describes how to install and uninstall VOP applications.

Note: The VOP server (SDP2) is installed separately. It is not 
installed as part of the MD-VOP installer. See "Installation" on 
page 5-6 for more information.

Default VOP Installation and File Directories
The following sections list the default installation and user file directories used by 
VOP, based upon the version installed.

Note: You can specify a different installation directory during the 
installation process. You can also modify MD-VOP launch scripts to 
change the default user file directory. See Appendix A, "Changing the 
Default MD-VOP User File Directory" for more information.

System Administrator Version
User is the user name currently logged in.

Windows Platform
VOP is installed in the following directory:

C:\Program Files\Multi Drive VOP SysAdmin

VOP stores user created files in the following directory:

Documents and Settings/User/.mdvop

All Other Platforms
VOP is installed under the User home directory, in a subdirectory named mdvop_sys.

VOP stores user created files under the User home directory, in a subdirectory named 
.mdvop.

Operator Version
User is the user name currently logged in.
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Windows Platform
VOP is installed in the following directory:

C: \Program Files\Multi Drive VOP Operator

VOP stores user created files in the following directory:

Documents and Settings/User/.mdvop

All Other Platforms
VOP is installed under the User home directory, in a subdirectory named mdvop_
operator.

VOP stores user created files under the User home directory, in a subdirectory named 
.mdvop.

Installing VOP
The VOP installer automatically installs MD-VOP, along with the following 
single-drive VOP applications:

■ T10000 9840D VOP

■ LTO-VOP

■ 9XXX VOP

During installation, you may choose whether to create desktop shortcuts for each VOP 
application.

To install VOP:

1. Navigate to the folder that contains the VOP installer files you downloaded in 
Chapter 2, "Obtaining VOP".

2. Run the appropriate installer for your operating system.

■ For Windows, double-click the executable (.exe) Windows file.

■ For UNIX, enter ./filename from a terminal screen, where filename is the 
MD-VOP install file you want to run.

3. When the initial dialog box appears, click Yes to continue.

4. When the Welcome screen appears, click Next to continue.

5. Read the license agreement and click the confirmation box to accept the terms. 
Then click Next to continue.

Note: If a previous version of MD-VOP is detected on your system, 
the program prompts you to remove the previous version. This is 
recommended, as running multiple versions of MD-VOP 
simultaneously may cause unpredictable results.
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6. Specify the desired destination folder for installation. Then click Next to continue.

7. Select whether to display the encryption tab in this installation of MD-VOP. Then 
click Next to continue.

8. Select whether you want the permanent encryption tab to be visible. Then click 
Next to continue.
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9. Confirm your setup options and click Next to begin installation.

Note: Please wait as VOP installs. A status bar appears to indicate 
installation progress.

10. Select your environment options and then click Finish.
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Environment options include the following:

Multi-Drive VOP:

■ View ReadMe - Displays the MD-VOP ReadMe file.

■ Launch Multi-Drive VOP - Starts MD-VOP after installation is complete.

■ Create Desktop Shortcut - Creates an MD-VOP desktop shortcut.

■ Create Quick Launch Shortcut - Creates an MD-VOP icon in the Quick Launch 
toolbar.

Single Drive VOP:

■ Create 9XXX VOP Desktop Shortcut

■ Create 9XXX VOP Quick Launch Shortcut (Windows only)

■ Create LTO VOP Desktop Shortcut

■ Create LTO VOP Quick Launch Shortcut (Windows only)

■ Create T10000 9840D Desktop Shortcut

■ Create T10000 9840D VOP Quick Launch Shortcut (Windows only)

11. Installation is complete.

■ If you selected Launch Multi-Drive VOP in the previous step, the MD-VOP 
application launches. See "Launching MD-VOP for the First Time" on page 6-1.

■ If you did not select Launch Multi-Drive VOP in the previous step, the 
installer closes. See Chapter 6, "Starting VOP".

Windows 7 File Permissions
If you installed VOP in Windows 7, you must ensure that permissions for the tmp, 
ftptemp, and ID directories (located in the VOP installation directory) are set to allow 
the current user to write to these directories. The VOP application uses these 
directories for temporary space when transferring files. If permissions are not set 
correctly, then certain features (for example, retrieving dumps) will not be available.

To set permissions:

1. In Windows Explorer, locate the directory. 
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2. Right-click the directory and then select Properties.

3. Click the Security tab and select Edit.

4. Select the current user or users (Current User\Users) and then select Full control.

5. Click Apply.

6. Click OK.

7. Click OK again.

Un-Installing VOP
All configurations and logs are retained after VOP is removed.

To Un-Install VOP (Windows)
Do the following:

1. Exit all running instances of VOP.

2. Perform one of the following steps:

■ From the Windows Start Menu, select All Programs, then Multi-Drive Virtual 
Operator Panel, and finally, Uninstall Multi-Drive Virtual Operator Panel.

■ From the VOP installation directory, run uninstall.exe.

3. An Uninstall Confirmation dialog appears. Click Yes to uninstall VOP.

4. When uninstall is complete, a confirmation screen appears.

To Un-Install VOP (UNIX)
Do the following:

1. Exit all running instances of VOP.

2. Enter the following command:

# cd <parent directory above the VOP installation directory>

Note: You must be one level above the installation directory. 
Otherwise, the terminal will lose the path.

3. Enter the following command:

# ./mdvop_sys/uninstall

4. When uninstall is complete, a confirmation screen appears.
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5VOP Client/Server Overview 

This chapter describes how to use VOP in a client/server configuration.

VOP consists of two main components:

■ VOP client

■ VOP server (SDP2 Service Delivery Platform 2)

The VOP client can be run in standalone mode (directly connected to a specific 
devices) or can be connected to the VOP server to direct all traffic through the server.

The VOP server serves as a single point of access to all devices, and is designed to 
reduce the number of device connections. It provides automated ASR functions and 
allows for additional logs to be collected.

VOP Client
The VOP client is designed to control and update the maintenance for different tape 
drives. It can be run in standalone mode (directly connected to a specific devices) or 
can be connected to the VOP server to direct all traffic through the server. In the 
MDVOP application, a configuration file tracks different configurations.

Figure 5–1 shows a standalone VOP client, which includes a direct connection to each 
device.

Figure 5–1 VOP Standalone Client Configuration

VOP Server
The VOP server serves as a single point of access to all devices, and is designed to 
reduce the number of device connections. It provides automated ASR functions and 
allows for additional logs to be collected. You can configure multiple VOP clients to 
communicate with the VOP server.

Figure 5–2 shows a VOP Client/Server configuration, which includes multiple VOP 
clients communicating with the VOP Server to manage devices.
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Figure 5–2 VOP Client/Server Configuration

As shown in the Figure 5–2, The VOP server contains multiple applications that run as 
Linux modules. These applications provide the main communication to each protocol 
as a central location for different devices and access.

Each module provides a specific function:

■ MDVOPServer

This module provides the GUI interface to the server and the main control system 
for the tape drives.

■ SnmpService - SNMP (simple Network Management Protocol)

This module receives events from different devices and controls all aspects of 
monitoring and maintaining processing.

■ ASPService - ASP (ASR Service Plus)

This module controls ASR and VSM related functions. It is responsible for sending 
alerts.

■ RmiRegistry - RMI (Remote Method Invocation)

This module provides the default level of communications between the GUI and 
server and also for inter process communication. This module is the default RMI 
installed.

■ FTPServer

This module receives alerts from the 9xxx tape drives.

Clients connect to the server through the RMI interface. The server handles any 
interaction through a private service network to the devices. This communication is 
local only. ASR and the drop box are the only outgoing interfaces that can be enabled 
or disabled.

The server uses a domain.vop file to control which devices are monitored. This file is 
only used by the server. To be monitored, the device must be included in this file. Any 
change to this file (for example, new device, change in IP) require the services to be 
restarted.

The VOP client uses a client configuration file. This file is a copy of the domain.vop 
file, or can be a subset of this file so that it includes only the devices you are interested 
in. If the domain is changed for selective areas, you must update the client 
configuration file.
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ASR
VOP can be used with Automated Service Request (ASR) to manage devices and 
collect logs by default. The ASR component must be enabled to function.

ASR is a feature of Oracle Premier Support for Systems and Oracle Limited Warranty 
that is designed to automatically request Oracle service when specific hardware faults 
occur. You can use ASR to manually or automatically request the creation of a service 
case. You must have a service contract for the device.

ASR is designed to resolve problems more quickly by eliminating the need to initiate 
contact with Oracle services for hardware failures, reducing both the number of phone 
calls needed and overall phone time required. ASR also simplifies support operations 
by utilizing electronic diagnostic data. ASR is easy to install and deploy is completely 
controlled by you to ensure security.

The ASR back-end infrastructure at Oracle collects all telemetry data forwarded to it 
from the ASR Manager. The fault-rule technology on these back-end systems 
ascertains the reality of the fault telemetry, and forwards recognized faults to Oracle's 
Service Request system. From there, the following actions occur:

■ A Service Request, also called a case, is created and assigned to an Oracle Support 
Engineer. At the same time, an e-mail notification of the Service Request is sent to 
your support contact on record associated with the system reporting a fault.

■ The Service Request is handled in accordance with the asset’s Support or Warranty 
contract.

For more information about ASR, refer to the ASR publications available at the 
following URL:

http://www.oracle.com/asr

Figure 5–3 shows an example of a configuration using a standalone VOP client. In this 
customer environment, VOP is directly connected to various devices. This allows for 
all general VOP functionality. All devices reside on the private service network.

Figure 5–3 ASR in a Standalone VOP Client Configuration

If the ASR component is enabled, then manual case creation can be performed through 
the DTS protocol to create the case and transfer logs. This protocol is sent through the 
secure layer.
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Figure 5–4 shows an example of a configuration using a VOP client communicating 
with the VOP (SDP2) server. The VOP client communicates with the VOP server while 
the VOP server communicates with the devices. All VOP functionality is performed 
through the GUI and redirected to the server.

Figure 5–4 ASR in a VOP Client/Server Configuration

In this configuration, if the ASR component is enabled, then the VOP server can create 
alerts after monitoring the devices for problems. The VOP client can still create a 
manual ASR as needed.

Figure 5–5 shows the different modes you can use to use VOP to communicate with 
Oracle Support.

Figure 5–5 VOP Modes of Communication with Oracle Support

In each mode shown in Figure 5–5, the primary goal is to use VOP functionality to 
maintain the supported devices:
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1. This mode is designed for access to devices, and allows for maintenance and 
support. If an issue must be uploaded, then the user can contact Oracle Support.

2. This mode includes a manually configured ASR, through either the standalone 
VOP client or the VOP server. The customer can manually create cases. VOP 
functionality to the devices is present.

3. This mode is designed for the creation of automated alerts. VOP functionality to 
the devices is present. Depending on customer requirements, this may allow 
Oracle support to remotely collect additional logs.

Installing the VOP Server
This section provides VOP server installation instructions and considerations.

Overview
The VOP server is installed as an RPM package installed from root. Before installing 
the VOP server, review the following server notes (assuming Oracle 6.4 Linux):

■ The application is designed to run as a regular user called sdp2admin.

– No special privileges for the account are required.

– The account requires a home directory used for collecting logs. Ensure that 
this directory has an appropriate disk size.

– All applications for this user run under this account.

– Installation requires a configured account. If the installation system contains 
NIS, LDAP, or related packages, contact your system administrator and Oracle 
support as necessary.

■ ip tables must be considered. Installing the application requires several ports to be 
open.

■ SE Linux is modified to allow the local copy of Java to be used by this application.

■ If root is required to run this application, contact Oracle support for details.

When you install the RPM package, the following actions occur:

■ The sdp2admin account is created.

■ The sdp2admin group is created.

■ ip tables are modified to redirect SNMP to a higher port for the user to access and 
requests SE Linux to enable the included copy of Java to run.

■ The application is installed under /opt/Oracle/Mdvopserver.

■ Entries are placed under init to start the application.

■ /etc/hosts is checked for an entry.

Library Complex Value
The Library Complex value is set by the SLConsole for each individual library. The 
customer or support representative can set or change this value.

Setting or changing this value impacts the VOP Server and StorageTek Tape Analytics 
(STA). The library complex value defines part of the IP address that is used in the 
private LAN ports for the library. This can cause the VOP Server (connected through a 
switch using a VLAN to the private network) to be unable to find the library. STA uses 
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the library complex value to identify a specific library complex. Changing this value 
can potentially cause loss of records for that library and associated tape drives.

Oracle recommends the following:

■ Establish a common library complex value when installing the VOP server and 
StorageTek Tape Analytics.

■ Once this value is established, do not change this value without careful 
consideration.

Changing this value is a user defined ability, and therefore cannot be controlled by 
additional software monitoring the environment.

Installation
To install the VOP server:

1. Edit the /etc/hosts file. To allow RMI to function properly, edit the hosts file with 
the IP address of the server along with the host name. Use a fully qualified host 
name.

If this file is not present, the GUI cannot connect to the server. Currently, only one 
IP address is supported for the GUI connection.

For example:

[sdp2admin@ttx4200-2 bin]$ cat /etc/hosts
127.0.0.1 localhost localhost.localdomain localhost6 localhost6.localdomain6
10.10.10.102 mdvop_server.us.oracle.com

In this example, the entry 10.10.10.102 mdvop_server.us.oracle.com is added to the 
/etc/hosts file. The host name and IP address identify the system for the 
installation.

2. Issue the following command to install the rpm package:

Note: If a previous version of the rpm package was installed, you 
must uninstall it. See "Upgrading and Uninstalling the VOP Server" 
on page 5-8 for more information.

rpm --install file_name

where file_name is the VOP server installation package.

The installation displays all steps performed and the completed output displays 
additional notes to be reviewed.

For example:

[root@dr-sdp2-OEL64-x86-4 ~]# rpm --install
MdvopServer-2.1.1-SNAPSHOT2013101519
1816.i686.rpm
pre 2.1.1
Installing..........
- Checking for Dependencies and creating a list that is needed.
Please Wait....
-(sdp2admin) exists!, No changes to Users Account
Working.....
post 2.1.1
Post Script Running..........
+Installing a local copy of Java into
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/opt/Oracle/MdvopServer/jre1.7.0_25!
+Successful with JVM Installation! Deleting Compressed file
+Modify sdp2admin Bash Profile, Please check SDP2_JAVA_HOME
Environment to be set correctly!
+Running MDVOP (SDP2) Server Setup
+Creating sdp2admin cron entry!
-User:sdp2admin Previous Server settings detected. No changes will be made!
+Attempting to run Administration Activities for Mdvop Server
for first time with (root) privileges!
+Configured System for use with Mdvop Server with java
preference (stand alone)
+Attempting to setup Mdvop Server for first time with (sdp2admin_ privileges!
+Configuring system wide init scripts! Selected runlevel will be (3,5)
+Configuring logrotate for Mdvop Server Application Logs!
+Checking network hosts file for IP configuration needed for RMI services
Finished with Package installation
posttran 2.1.1

Configuring and Running the Server
Perform the following steps to verify and configure the VOP server (SDP2) basic 
settings:

1. Login as (sdp2admin) or <su - sdp2admin> as root.

2. <cd /opt/Oracle/MdvopServer> or alternatively use <cd SDP2_HOME> and then 
<ls>.

3. Verify permissions are sdp2admin:sdp2admin on folders.

4. If a local java was installed, this is the top level directory. Look for a Java folder 
(for example, jre1.7.0.25)

5. <cd bin> and then issue <ls>.

6. Verify that preinstallation is complete. If the file (jreConfig) is present, then a 
suitable Java has been found.

Issue the command <./Server.sh config>. If successful, then the file will exist. 
Otherwise, you must manually configure it.

Alternatively, issue <./detectJava.sh> and review the output to determine whether 
a JVM was found.

7. Issue <ls /setup> to verify that there is a directory (bin/setup).

■ If change (changeSnmpPort) exists, then the firewall was modified.

■ If change (secureJava) exists, then SE Linux is aware that a local copy of Java is 
being used.

8. As an administrator, verify that /etc/hosts file contains the server IP address and 
correct DNS name.

9. Issue <./Server.sh start> to start the Mdvop server services. After services start, 
issue <./Server.sh status> to verify that services are active.

Considerations
Note the following considerations:

■ You can run the server from anywhere with the command <mdvop_server start>. 
Please do not run as root!
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■ General logs of the process are located in /opt/Oracle/MdvopServer/logs.

■ If you receive a message indicating that a port is in use, verify that other RMI 
processes are not running.

■ Local server documents are located in /opt/Oracle/MdvopServer/docs.

■ Java search order is as follows:

1. If this installation process was able to detect the correct machine architecture 
(i686), then a JRE (Java Runtime Environment) was installed under the top 
level directory.

2. If you are using an x64 architecture, the JRE was not installed and the 
installation likely used the native operating system version detected.

3. If the installer could not detect an architecture, then you must manually install 
a compatible version of Java.

After you install Java, point the (/opt/Oracle/MdvopServer/bin/jreConfig) 
file to the parent directory of the JVM (Java Virtual Machine). For example:

<which java> yields (/usr/bin/java)

</usr/bin/java -version> yields (java version 1.7.0_25)

<echo /usr > /opt/Oracle/MdvopServer/bin/jreConfig>

Note: Use double quotes with echo!

Verify with <cat /opt/Oracle/MdvopServer/bin/jreConfig> yields (/usr)

Starting the VOP Server
After installation and setup, the administrator can either restart the server or issue the 
following commands to start the application:

su - sdp2admin
mdvop_server start

See "Scripts" on page 5-9 for details.

To verify whether the VOP server is installed, issue the following command:

rpm -qa | grep -i mdvop

For example:

[root@dr-sdp2-OEL64-x86-4 ~]# rpm -qa | grep -i mdvop
MdvopServer-2.1.1-SNAPSHOT20130919151818.i686

Upgrading and Uninstalling the VOP Server
To upgrade to a newer version for this release, you must install and then reinstall the 
package. The following actions occur:

■ All running modules are stopped.

■ The /opt/Oracle/Mdvopserver is removed.

■ The SNMP port entry in the iptables is removed.

■ All settings are saved for reuse.
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■ The user account sdp2admin is retained to retain existing configuration and 
additional data. If you want to perform a full removal of the application, you must 
manually remove this user.

To remove the VOP server, issue the following command:

rpm -e MdvopServer

For example:

[root@dr-sdp2-OEL64-x86-4 ~]# rpm -e MdvopServer
preun 2.1.1
Removing........
Stopping MDVOPServer: [ OK ]
Stopping SnmpService: [ OK ]
Stopping ASPService: [ OK ]
Stopping RmiRegistry: [ OK ]
+User:sdp2admin Mdvop Server Settings were archived in
/home/sdp2admin/MdvopServer-20131016084200OURCE-Settings.tar.gz
-User:sdp2admin was not removed from the System
postun 2.1.1
Removed Package, Cleaning up........
FINISHED

Scripts
Use the mdvop_server script to start and stop the VOP server. This script is included 
in the path for the account.

Using no arguments displays the available commands. For example:

[sdp2admin@dr-sdp2-OEL64-x86-4 ~]$ mdvop_server
Usage: /usr/local/bin/mdvop_server {start|stop|restart|reload|status}

To start the application, issue the following command:

mdvop_server start

For example:

[sdp2admin@dr-sdp2-OEL64-x86-4 ~]$ mdvop_server start
Starting RmiRegistry: [OK]
Starting ASPService: [OK]
Starting SnmpService: [OK]
Starting MDVOPServer: [OK]
[sdp2admin@dr-sdp2-OEL64-x86-4 ~]$

To stop the application, issue the following command:

mdvop_server stop

For example:

Stopping MDVOPServer: [OK]
Stopping SnmpService: [OK]
Stopping ASPService: [OK]
Stopping RmiRegistry: [OK]

To view the status of the application, issue the following command:

mdvop_server status

For example:

[sdp2admin@dr-sdp2-OEL64-x86-4 ~]$ mdvop_server status
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RmiRegistry (pid 3232) is running...
ASPService (pid 3250) is running...
SnmpService (pid 3289) is running...
MDVOPServer (pid 3322) is running...
[sdp2admin@dr-sdp2-OEL64-x86-4 ~]$
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6Starting VOP 

This chapter describes how to start VOP applications.

Note: Single-drive VOP applications may be started within 
MD-VOP, or separately as standalone applications.

Starting MD-VOP
This section describes how to start MD-VOP in both Windows and UNIX 
environments.

Starting MD-VOP (Windows)
To start MD-VOP, do one of the following:

■ Click the Windows Start menu and select All Programs, Multi-Drive VOP, and 
then Multi Drive VOP.

■ Double-click the Multi-Drive VOP desktop shortcut (optionally enabled during 
installation).

■ Double-click the Multi-Drive VOP Quick Launch shortcut icon (optionally 
enabled during installation).

When you start MD-VOP, there is a minimal delay as the application starts. During 
loading, a progress bar appears. There may be an additional delay as VOP connects to 
tape drives and determines the current state of the tape drive(s).

Starting MD-VOP (UNIX)
To start MD-VOP, do one of the following:

■ Run the file named mdvop from the installation directory. (Use a relative path, 
symbolic links, or add the VOP directory to your $PATH environmental variable.)

■ Double click the Multi-Drive VOP desktop icon (if supported).

Launching MD-VOP for the First Time
When you launch MD-VOP for the first time, an MD-VOP Default screen displaying 
the Oracle logo appears.

Note: This screen also appears if you have not defined an existing 
configuration as the default.
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■ To create a new standalone client MD-VOP configuration, click the File menu and 
select Edit Configuration.

A default Configuration screen appears. See "Using the MD-VOP Configuration 
Screen" on page 8-3 for more information about creating a new configuration.

■ To open an existing standalone client MD-VOP configuration, click the File menu 
and select Launch Configuration.

The MD-VOP interface appears and the configuration opens. See Chapter 7, 
"Using the MD-VOP Interface" for more information.

■ To create or update a new server configuration, click MDVOP Server and select 
Edit Domain Configuration File on Server. See "Edit Domain Configuration File 
on Server" on page 8-16 for more information.

■ To create a client configuration, click the File menu and select Create Client 
Configuration File from Server. See "Create Client Configuration File from 
Server" on page 8-14. 

Starting T10000 9840D VOP
You can start T10000 9840D VOP either from within the MD-VOP application, or from 
the desktop.

Starting T10000 9840D VOP within MD-VOP
To start T10000 9840D VOP within MD-VOP, click a drive to display the SDVOP view 
for that tape drive.

Starting T10000 9840D VOP from the Desktop
To start T10000 9840D VOP from the desktop, do the following:

Note: A physical connection between your processing platform and 
the Ethernet port on the tape drive is assumed.

1. Double-click the T10000 9840D VOP desktop icon (if specified during installation). 
An Authentication dialog box appears.

2. Enter the IP address of the physically-connected tape drive, and click the Connect 
button. Otherwise, click Cancel to exit the application.

Starting LTO-VOP
You can start LTO VOP either from within the MD-VOP application, or from the 
desktop.

Starting LTO VOP within MD-VOP
To start LTO VOP within MD-VOP, click an LTO tape drive to display the SDVOP view 
for that tape drive.

Starting LTO VOP from the Desktop
To start LTO VOP from the desktop, do the following:



Note: A physical connection between your processing platform and 
the Ethernet port on the tape drive is assumed.

Starting 9XXX VOP
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1. Double-click the LTO VOP desktop icon (if specified during installation). The LTO 
VOP interface appears.

Because LTO VOP is not yet communicating with a tape drive, the Connect button 
is gray and all status indicators are black.

2. Enter the IP address of the tape drive Ethernet port in the field next to the Connect 
button.

3. Click the Connect button.

Once connection is established, The IP address appears in the title bar, the status 
indicators are no longer black, and data appears in the Monitor Drive tab.

Starting 9XXX VOP
You can start 9XXX VOP either from within the MD-VOP application, or from the 
desktop.

Starting 9XXX VOP within MD-VOP
To start 9XXX VOP within MD-VOP, click a tape drive to display the SDVOP view for 
that tape drive.

Starting 9XXX VOP from the Desktop
To start 9XXX VOP from the desktop, do the following:

Note: A physical connection between your processing platform and 
the Ethernet port on the tape drive is assumed.

1. Double-click the 9XXX VOP desktop icon (if specified during installation). The 
9XXX VOP interface appears.

2. Click the File Menu and select Connect to Drive. The Connect to Drive dialog box 
appears.

3. Enter the IP address of the physically-connected T9x40B or T9x40C tape drive, and 
click the Connect button. Otherwise, click Cancel to exit the dialog box.
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7Using the MD-VOP Interface 

This chapter describes how to use the MD-VOP interface.

MD-VOP Interface Overview
Designed for ease of use, the MD-VOP Graphical User Interface (GUI) enables you to 
do the following:

■ Navigate through multiple account configurations, including libraries and tape 
drives.

■ Monitor, configure, and diagnose Oracle StorageTek tape drives.

■ View the current state of all tape drives to monitor problems as they occur.

■ Perform mass functions for multiple tape drives, including firmware updates, 
obtaining logs and dumps, and encryption.

■ Create My Oracle Service (MOS) issues using the Auto Service Request (ASR) 
feature.

■ Connect a VOP client to the VOP server.

■ Configure the VOP server to enable automated alerts for selective products.

Figure 7–1 shows the MD-VOP main interface:
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Figure 7–1 MD-VOP Main Interface

Legend:

1. Dashboard

2. Library Panel

As shown in Figure 7–1, The MD-VOP interface is divided into two sections:

■ The Dashboard displays the general state of all tape drives in your configuration.

■ The Library Panel displays information for tape drives in a selected library or 
VSM.

Both sections include menus you can use to perform various functions on selected tape 
drives.

Dashboard
The Dashboard displays the general state of all tape drives in your configuration. It 
displays the number of tape drives in each drive state, for both a selected library and 
the entire MD-VOP configuration.

Note: A tape drive can be in multiple states at a given time.

The dashboard includes menus you can use to create, launch, and save configurations, 
and perform other configuration tasks.

Figure 7–2 shows the MD-VOP dashboard:
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Figure 7–2 MD-VOP Dashboard

Legend:

1. Menus

2. Title

3. Library Name

4. View button

5. Drive State Counts

As shown in Figure 7–2, the Dashboard includes the following:

Menus

Use menus to create, update, or launch an MD-VOP configuration. See Chapter 8, 
"Using MD-VOP Dashboard Menus" for more information.

Title

The configuration name as defined on the MD-VOP Configuration screen.

Library Name

The library name that was created when the configuration was built. When you click a 
library name in the dashboard, the corresponding library tab is actively displayed in 
the library panel.

View Button

Click this button to toggle between the Dashboard view and Full view. In the 
Dashboard view, the Library Panel is hidden.

Drive State Counts

Displays the number of tape drives in each of the following drive states:

■ Loaded

■ Unloaded

■ Empty

■ Offline

■ Alert

■ Dump

■ Unavailable
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Separate counts are displayed for the selected library, and for all tape drives in the 
MD-VOP configuration.

Note: A tape drive may be in multiple states at a given time.

See "Drive States" on page 7-10 for a description of these drive states.

Library Panel
The Library Panel displays information for tape drives in a selected library. 

It includes menus you can use to control, update, and view selected tape drives within 
the library.

Figure 7–3 shows the MD-VOP Library Panel:

Figure 7–3 MD-VOP Library Panel

Legend:

1. Library/VSM tabs

2. Drive View tabs

3. Menus

4. Legend

5. Drive Details

6. Drive Selection Panel

As shown in Figure 7–3, the Library Panel includes the following:

Library/VSM Tabs
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These tabs display library names. A separate tab is created for each library in your 
configuration.

■ When you click a library tab, it becomes active, and the Library Panel displays 
tape drive information specific to that library.

■ When you click the VSM tab in the Library Panel, the Library Panel displays VSM 
information for configured VSMs. See "VSM Tab" on page 7-7 for more 
information.

Drive View Tabs

These tabs display different types of tape drive information for the tape drives in the 
selected library.

When you click a tab, it becomes active, and the legend and Drive Details section 
display accordingly. See "Drive States" on page 7-10 for information about each drive 
state.

Menus

Use menu commands to manipulate or obtain data for one or more selected tape 
drives. See Chapter 9, "Using MD-VOP Library Panel Menus" for more information.

Note: If the SDVOP View tab is selected, these menus change to 
provide commands specific to the selected tape drive.

Legend

The legend provides a visual key for the information displayed in the Drive Details 
section of the Library Panel. The legend is based on the Drive View tab that is active.

Drive Details

The Drive Details section displays an icon for each tape drive in the selected library. 
These icons are color coded according to the legend.

You can perform the following functions:

■ Click an individual tape drive icon to display the Single Drive Virtual Operator 
Panel (SDVOP) View for that tape drive. See "SDVOP View" on page 7-14 for 
information.

■ Ctrl-click a tape drive icon to select or unselect the tape drive. Once you select a 
tape drive, you can issue Library Panel menu commands for that drive.

■ Right-click a tape drive icon to display functions that can be performed on that 
tape drive.

These are the same functions provided in the Library Panel’s Drive Operations 
menu. See "Drive Operations Menu" on page 9-2 for a description of these 
functions.

■ Mouse-over a tape drive icon to display the following information for that drive:

– Drive state

ONLINE or OFFLINE.

– Cartridge

LOADED or EJECTED.

– Dump
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AVAILABLE or NOT AVAILABLE.

– Drive Name

The tape drive name as defined in the MD-VOP Configuration screen.

– Volser

The volume serial number of a tape, if present and detected in the tape drive.

– Serial Number

The internal serial number of the tape drive.

– Firmware Level

The firmware currently loaded on the tape drive.

– Port A WWN

The World Wide Name for port A.

– Port B WWN

The World Wide Name for port B.

– IP Address

The IP address defined for the tape drive.

– Host Name

The host name, if detected from DNS.

– Library Slot Location

The physical slot location in the library.

– Library Internal Location

The physical location in the library as defined internally to the library (SL8500 
and SL3000 only).

– ACSLS/HLI Address

The location that would appear in the ACS (SL8500 and SL3000 only).

– Tray SN

The serial number entered on the MD-VOP Configuration screen, used for 
support.

– Licensed

true or false, to indicate whether the tape drive is licensed for encryption.

– Encryption Type

The type of encryption used on this tape drive.

– Encryption State

Enrolled or Unenrolled, to indicate whether the tape drive can obtain keys 
from OKM.

– Agent ID

The OKM agent id.

– KMS IP

The OKM IP address.
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Drive Selection Panel

Use the Drive Selection Panel to select multiple tape drives based on different criteria. 
This panel applies only to the library that is currently selected.

You can perform the following functions:

■ Click the Select All Drives button to select all tape drives in the library.

■ Click the Unselect All Drives button to unselect all tape drives in the library.

■ Click the Multi-Select Drive Types check boxes to select specific drive types.

■ Click the Add Firmware Level drop-down menu to select a specific level of tape 
drive firmware.

Note: This can help you identify tape drives that are not at the 
appropriate firmware level.

VSM Tab
In server mode, if one or more VSMs are configured, a VSM tab appears in the Library 
Panel. When you click the VSM tab, the Library Panel displays VSM information for 
configured VSMs, as shown in Figure 7–4.
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Figure 7–4 VSM Information

The following VSM information is displayed:

■ VSM Name

■ IP Address

■ Product Name

■ Serial Number

■ Entitled Number

■ Firmware

The ASR tab enables you to use the ASR feature. See "ASR" on page 7-15.

MD-VOP Drive Views
The MD-VOP Library Panel includes the following drive view tabs, used to display 
different types of information for tape drives in a selected library:

■ "Drive State View" on page 7-9
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■ "Encryption View" on page 7-10

■ "Drive Health View" on page 7-12

■ "MD-VOP Transcript" on page 7-14

■ "SDVOP View" on page 7-14

■ "ASR" on page 7-15

Note: By default, the Encryption view is not displayed, unless you 
indicated to include it when you installed MD-VOP. You can activate 
this view using the MD-VOP Default Settings screen. See "Changing 
MD-VOP Default Settings" on page 8-17 for more information.

Drive State View
From the MD-VOP Library Panel, select the Drive State View tab to display the 
current state of the tape drives in the selected library. You may encounter a minimal 
delay when this view is selected.

This view is only supported for the T9840D, T10000 series, and LTO 4/5 tape drives. 
All other drives will display a white icon as an indicator of connection, for which other 
logs can be obtained.

Figure 7–5 shows an example of the Drive State view:

Figure 7–5 Drive State View Example

Drive State View Legend
Figure 7–6 shows the legend displayed in the Drive State View:



MD-VOP Drive Views

7-10 Oracle Virtual Operator Panel 2.2 User’s Guide

Figure 7–6 Drive State View Legend

You can use the legend to filter the tape drives that are displayed in the Library Panel. 
Click the check box for a particular drive state to include or exclude applicable drives 
in the Library Panel.

Drive States  By default, the legend includes the following drive states:

Note: You can customize icon labels and colors. See "Changing 
MD-VOP Default Settings" on page 8-17 for more information. 
Figure 7–6 shows the legend displayed after a first time installation.

Loaded

A tape cartridge is loaded and is ready to be used by the tape drive. This status is 
green by default.

Unloaded

A tape cartridge is unloaded. The tape cartridge resides in the tape drive, but is not 
actually threaded through the tape drive. This status is brown by default.

Empty

There is no tape cartridge in the tape drive. This status is blue by default.

Offline

The tape drive has been set to not allow some activity to the backup system. This state 
is used for maintenance to the tape drive. In this state, commands from the host 
(backup server) are not processed. This status is gray by default.

Alert

The tape drive is in need of cleaning due to periodic or error detection limits. 

This status is yellow by default.

Dump

A dump can occur for a problem that falls outside of the limits in the firmware on the 
tape drive. This is an SNO (should not occur) in a memory dump from the tape drive. 
Send the dump to Support for analysis. This status is orange by default.

Unavailable

A tape drive is not communicating with MD-VOP. This status is black by default.

Encryption View
From the MD-VOP Library Panel, click the Encryption View tab to display the current 
encryption state of the tape drives in the selected library. You may encounter a 
minimal delay when this view is selected.



Note: By default, the Encryption view is not displayed, unless you 
indicated to include it when you installed MD-VOP. You can activate 
this view using the MD-VOP Default Settings screen. See "Changing 
MD-VOP Default Settings" on page 8-17 for more information.
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Only T9840D, T10000 series, and encrypting LTO tape drives support encryption 
through an Oracle Key Manager (OKM) system.

Figure 7–7 shows an example of the Encryption view:

Figure 7–7 Encryption View Example

Encryption View Legend
Figure 7–8 shows the legend displayed in the Encryption View:

Figure 7–8 Encryption View Legend

You can use the legend to filter the tape drives that are displayed in the Library Panel. 
Click the check box for a particular drive state to include or exclude applicable tape 
drives in the Library Panel.

Encryption States  By default, the legend includes the following encryption states:

Note: You can customize icon labels and colors. See "Changing 
MD-VOP Default Settings" on page 8-17 for more information.
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Armed

The tape drive has acquired an encryption key from OKM. The tape drive can write 
encrypted data. This status is green by default.

Enrolled

The tape drive is enrolled with OKM but does not have an encryption key from OKM. 
This status is blue by default.

Unenrolled

The tape drive has been reset and is no longer enrolled with OKM. The tape drive 
cannot write encrypted data. This status is gray by default.

Unlicensed

The tape drive is capable of encryption, but the license key for the tape drive has not 
been sent to the tape drive. This status is white by default.

Not ecpt

The tape drive is not capable of encryption. This status is white by default.

Unavailable

The tape drive is not communicating with MD-VOP. This status is black by default.

Drive Health View
From the MD-VOP Library Panel, click the Drive Health View tab to display the 
current health status of the tape drives within the selected library. You may encounter 
a minimal delay when this view is selected.

Note: At MD-VOP startup, the “good” state color is indicated by 
default. This remains until you issue a Perform Health Check 
command from the Library Panel Drive Operations menu. See "Drive 
Operations Menu" on page 9-2 for more information.

Figure 7–9 shows an example of the Drive Health view:
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Figure 7–9 Drive Health View Example

Drive Health View Legend
Figure 7–10 shows the legend displayed in the Drive Health view:

Figure 7–10 Drive Health View Legend

You can use the legend to filter the tape drives that are displayed in the Library Panel. 
click the check box for a particular drive state to include or exclude applicable tape 
drives in the Library Panel.

Drive Health States  By default, the legend includes the following drive health states:

Note: You can customize icon labels and colors. See "Changing 
MD-VOP Default Settings" on page 8-17 for more information.

Normal

No events are found on the tape drive. This status is green by default.

Warning

The tape drive has a concern that requires review. This status is yellow by default.

Alert

The tape drive requires attention. This status is also triggered when the tape drive is 
unavailable for connection. This status is red by default.
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MD-VOP Transcript
From the MD-VOP Library Panel, click the MD-VOP Transcript tab to display all 
global commands sent or received from the tape drives in the selected library.

Note: You may encounter a minimal delay when this view is 
selected.

MD-VOP transcripts are stored in the transcripts subdirectory within the MD-VOP 
application folder. Figure 7–11 shows an example of the MD-VOP Transcript view:

Figure 7–11 MD-VOP Transcript View Example

SDVOP View
Click a tape drive icon in the Library Panel to access the SDVOP (single-drive) View 
for that tape drive. The SDVOP View tab becomes active.

■ If you click a T9840D or T10000 tape drive, the T10000 9840D SDVOP interface is 
displayed in the MD-VOP Library Panel. See Chapter 10, "Using T10000 9840D 
VOP" for information about using T10000 9840 VOP.

■ If you click an LTO tape drive, the LTO VOP interface is displayed in the MD-VOP 
Library Panel. See Chapter 11, "Using LTO VOP" for information about using LTO 
VOP.

■ If you click a T9840B, T9840C, T9940A, or T9940B tape drive, the 9XXX VOP 
interface is displayed in the MD-VOP Library Panel. See Chapter 12, "Using 9XXX 
VOP" for information about using 9XXX VOP.

Figure 7–12 shows an example of the SDVOP view for a T10000 tape drive:
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Figure 7–12 SDVOP View Example

As shown in Figure 7–12, the SDVOP View is active, and the T10000 9840D VOP 
interface is displayed in the MD-VOP Library Panel.

ASR
From the MD-VOP Library Panel, click the ASR tab to display the ASR view.

Note: You may encounter a minimal delay when this view is 
selected.

The following sections describe how to establish ASR functionality and configure 
devices for use with ASR.

Establishing ASR Functionality for a Device
Under the client/standalone VOP:

1. Register the application. See "ASR Register" on page 7-17.

2. Configure one or more devices to VOP and enter serial numbers where 
appropriate.

3. Activate the assets. See "ASR Activate" on page 7-18.

4. Access My Oracle Support (MOS) and confirm that the assets are activated.

For more information, visit the following URL:

http://www.oracle.com/technetwork/systems/asr/documentation/index.html

5. Optionally, send a test message or simulate an event.

To enable the automatic ASR feature included in the VOP server:

■ For libraries, click the SNMP button on the Domain Configuration page. See "Edit 
Domain Configuration File on Server" on page 8-16.
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■ For VSM, click the Domain Configuration page. This automatically configures the 
VSM and server. See "Edit Domain Configuration File on Server" on page 8-16.

■ For T10000 tape drives:

1. Access the MDVOP single drive view for the drive and place the drive offline. 
See "SDVOP View" on page 7-14.

2. Access the data from the drive and select the SNMP tab.

3. Enter the IP address for the server and select Save. The drive reboots.

For a 9xxx tape drive, use the edit MIM to configure the device. You can configure 
a single device or multiple devices. If you are configuring a single device, go to the 
single drive view. See SDVIEW.

1. Place the tape drive offline.

2. Under Configuration, select MIM. The MIM File Configuration screen 
appears:

Figure 7–13 Mim File Configuration screen

3. Enter the Host IP address for the server (use the port that the tape drives is 
attached to). Then click OK.

Note: Only use the Advanced Settings tab as directed by Oracle 
support.

Figure 7–14 shows an example of the MD-VOP ASR view:
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Figure 7–14 ASR View Example

As shown in Figure 7–14, the ASR view includes the following tabs:

■ ASR Register

■ ASR Activate

■ ASR Creation

■ ASR Log

■ ASR Test

By default, the ASR Activate page is selected when you click the ASR tab.

Before you can create a service request, you must first register with MOS (using the 
ASR Register tab) and activate your devices (using ASR Activate tab).

ASR Register
To use the ASR feature, you must first register with the My Oracle Support (MOS) to 
confirm that this is a valid application capable of sending data. This step establishes an 
unique key so that all additional traffic can be matched to a product.

To register:

1. In the Enter valid Oracle MOS account field, enter your My Oracle Support (MOS) 
username and password.

2. Enter ASR Manager internet settings. The ASR Manager is a system that centrally 
accepts hardware telemetry data sent from a group of ASR Assets. The ASR 
Manager filters the incoming data and forwards potential fault telemetry to Oracle 
ASR back-end systems.

3. Optionally, if you are accessing the internet through a proxy, click the Enable 
Proxy Configuration check box and provide the following:

– Proxy server host name

– Proxy port number
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– Proxy user name

– Proxy password

– NTLM Domain Name (if applicable)

– NTLM Host Name (if applicable)

Note: If you access the internet through a proxy, check with your 
network administrator to collect information needed to configure the 
ASR Manager system.

4. Click the Submit button to register with the supplied information, or click the 
Clear button to cancel the operation.

ASR Activate
Click this tab to display the ASR Activate page. Use this page to activate one or more 
tape drives. to create an ASR for a particular tape drive, you must first activate the 
tape drive. By default, libraries are automatically added to the activate list.

To activate a tape drive, select it from the Available Devices window and drag and 
drop it in the Selected/Activated Devices window.

Devices are listed with the following information:

■ drive type

■ internal serial number

■ tray serial number

■ entitled status

Note: An asterisk indicates a device that has already been activated.

After you activate one or more tape drives, the Account Manager must enable these 
ASR Assets in My Oracle Support. Otherwise, any alerts you attempt to send will be 
dropped. Refer to the Oracle Auto Service Request Installation and Operations Guide for 
instructions. A valid service contract is required.

ASR Creation
Click this tab to display the ASR Creation page. Use this page to create a MOS Service 
Request, or Case, for one or more tape drives.

Note: Before you can create a service request, you must first register 
with MOS (using the ASR Register tab) and activate your devices 
(using the ASR Activate tab).

To create a Service Request:

1. Click the drop-down menu and select an activated tape drive for which to create a 
MOS Service Request.

2. Select additional devices for the Service Request. Drag and drop devices from the 
Available Devices window to the Selected drives window.
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3. Enter any additional information to be included in the Service Request.

4. Click the Create ASR button to create the Service Request in MOS, or click the 
Clear button to cancel the operation.

Once the Service Request is created in MOS, logs are automatically collected, 
transmitted to the Oracle ASR back-end system, and attached to the Service Request.

ASR Log
Click this tab to view a running log of ASR activity. Logs are not produced for LTO 
drives.

ASR Test
Click this tab to test end-to-end communications between a tape drive and the Oracle 
ASR back-end system.

Note: Before you can test communications, you must first register 
with MOS (ASR Register tab) and activate your devices (ASR Activate 
tab).

To test communications:

1. Click the drop-down menu and select an activated tape drive.

2. Click the Test button.

When the test completes, the user registered under MOS receives a confirmation 
e-mail indicating whether the test was successful. If the test fails, the e-mail includes 
possible causes.



MD-VOP Drive Views

7-20 Oracle Virtual Operator Panel 2.2 User’s Guide



8

Using MD-VOP Dashboard Menus 8-1

8Using MD-VOP Dashboard Menus 

This chapter describes how to use the MD-VOP Dashboard menus.

Use MD-VOP Dashboard menu commands to create or edit an MD-VOP 
configuration, and to specify application settings. A configuration applies to the 
libraries and tape drives that are to be displayed in the Drive Details section of the 
Library Panel.

The Dashboard includes a File Menu and Help Menu.

File Menu
The File menu includes the following commands:

Launch Configuration

Displays a pop-up window you can use to open a previously saved local 
configuration. This only applies in standalone mode, with a direct connection to the 
device.

Edit Configuration

Displays the Configuration screen, used to create a new configuration or edit and 
existing configuration. See "Using the MD-VOP Configuration Screen" on page 8-3 for 
more information.

MDVOP Server

Displays a submenu of options used to configure the MDVOP server component. See 
"Using the MDVOP Server Menu Options" on page 8-14 for more information. 

Set as Default Configuration File

Sets the current configuration as the default. This configuration is automatically 
loaded the next time you start MD-VOP.

Edit Library Probe Configuration

Displays the Library Probe Configuration dialog box, used to set defaults for 
establishing communication with a tape library. These defaults are applied on the 
Configuration screen when you enter the IP address for an SL500, SL3000, or SL8500 
library.

Enter the following default library probe settings:

■ Default User

The account used to connect to a library. Enter an account or select one of the 
following from the drop-down menu:
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– admin - The general administration account provided to you.

– remote - Remote user for libraries.

– acsss - Placeholder for future ACSLS functionality.

– oem - An OEM account from a partner. Also used for libraries.

■ Default Password

The password for the default account. Once you connect to a library, you can 
change the password to be specific to that library.

■ Unknown Host Authorization

Applies when using SSH for communication. Library credentials can be displayed 
for you to accept or decline.

Select one of the following from the drop-down menu:

– Auto - SSH credentials are not displayed, and are automatically accepted.

– Prompt - SSH credentials are displayed and you are prompted to accept or 
decline.

■ Connection Timeout

The timeout value, in seconds, for the connection within SSH while establishing a 
connection to the library.

■ Process Execution Timeout

The timeout value, in seconds, for an individual command being sent.

MDVOP Default Settings

Displays the Default Settings screen, used to edit MD-VOP display settings. See 
"Changing MD-VOP Default Settings" on page 8-17 for more information.

Get MDVOP Logs for Support

Collects all MD-VOP logs and saves them in a zip file at the specified location.

Launch

Launches an existing configuration. The five most recent configurations are listed.

Exit

Exits the MD-VOP application.

Note: You can also click the “X” icon in the upper right corner of the 
window to exit the MD-VOP application.

Help Menu
The Help menu includes the following commands:

Contact Support

Displays a warranty statement and information about contacting Oracle to obtain 
MD-VOP support.

About

Displays the following information about the MD-VOP application and environment:

■ Role level access
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■ MD-VOP Version

■ MD-VOP Build Date

■ VOP Version

■ VOP Build Date

■ Java Version

■ License Agreement

Using the MD-VOP Configuration Screen
From the Dashboard, click the File menu and select Edit Configuration to access the 
Configuration screen.

Use this screen to create a new MD-VOP configuration, or edit an existing MD-VOP 
configuration. You can also use this screen to find a tape drive, probe a range of IP 
addresses, or change the IP address of a tape drive.

Figure 8–1 shows the Configuration screen:

Figure 8–1 MD-VOP Configuration Screen

Legend:

1. Title

2. Menus

3. Tabs

4. Configuration Name
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5. Library Type

6. Action

As shown in Figure 8–1, the Configuration screen includes the following:

Title

The file name used to create this configuration.

Menus

Use menus to issue MD-VOP configuration commands. See "Configuration Menus" on 
page 8-7 for more information.

Tabs

A Configuration tab is displayed, along with additional tabs for each library you add. 
click a library tab to display its Library Spreadsheet page, where you can define 
detailed settings for the library. See "Library Spreadsheet Page" on page 8-4 for more 
information.

Configuration Name

The configuration name as displayed on the MD-VOP dashboard.

When you create a new MD-VOP configuration, Default Name is displayed. Overwrite 
this value with your new configuration name.

Library Type drop-down menu

Click this drop-down menu to select a library type to be added or deleted. This 
selection defines the possible types of slots available.

Action

Click this button to add or remove a library from the MD-VOP configuration.

■ When you add a library, a new tab is created, and the Library Spreadsheet page for 
the new library is displayed. Use this page to define your library settings. See 
"Library Spreadsheet Page" on page 8-4 for more information.

■ When you delete a library, all entries for that library are removed.

Library Spreadsheet Page
To display the Library Spreadsheet page for a particular library, click the appropriate 
library tab from the MD-VOP Configuration screen. Use the Library Spreadsheet page 
to define or view detailed library settings.

Figure 8–2 shows an example of the Library Spreadsheet page.
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Figure 8–2 Library Spreadsheet Page

Legend:

1. Library Settings

2. Tape Drive Settings

3. Drive Definition Spreadsheet

As shown in Figure 8–2, the Library Spreadsheet page is divided into three sections:

■ "Library Settings" on page 8-5

■ "Tape Drive Settings" on page 8-6

■ "Drive Definition Spreadsheet" on page 8-6

Library Settings
The Library Spreadsheet page includes the following library settings:

Lib Name

Specify the library name. This is used as the user-defined library name.

Number of Drive Bays (SL3000 only)
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Specify the number of optional tape drive modules.

IP Address

Specify the IP address for the library.

Lib SN

Specify the serial number for the library.

Click the Probe button to perform a probe based on the specified settings. Once the 
probe completes, the Library Spreadsheet is automatically populated with the results 
of the probe.

Tape Drive Settings
The Library Spreadsheet page includes the following tape drive settings:

IP Address Preamble

Optionally, enter the first three fields of the tape drive IP address. This will be used as 
the preamble for the IP specification in the second column of the Drive Definition 
spreadsheet. This preamble will be appended to that specification to form the 
complete IP address.

Auto-fill Drive Name

Use these options to automatically populate the Drive Name column of the Drive 
Definition spreadsheet:

■ Off

Do not attempt to automatically populate the Drive Name column.

■ IP Address

Use the IP address as the default name in the Drive Name column.

■ Slot Number

Use the slot location as the default name in the Drive Name column.

■ DNS Node Name

Use the DNS entry for the IP address (if detected) as the default name in the Drive 
Name column.

Auto-probe for drives

Direct MD-VOP to probe for drive type and serial number when you enter an IP 
address on the Drive Definition spreadsheet. Click ON to enable this feature. Click 
OFF to disable this feature.

Drive Definition Spreadsheet
The Drive Definition spreadsheet includes six columns:

1. Slot number

The library slot in which the tape drive is located.

2. IP Address

The IP address of the tape drive.

3. Drive Name

Human readable name of the tape drive. This field can be user entered.
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4. Drive Type (special)

The model of the tape drive in this slot. The value of this field determines which 
connection protocol and single-drive VOP style to use when connecting to this 
tape drive:

■ Telnet

T10000 family, T9840D. Detected by probe operation.

■ LTO

Ethernet-enabled encryption HP and IBM LTO4/5. Detected by probe 
operation.

■ FTP

T9840B/C, T9940B. Detected by probe operation.

■ Placeholder

Indicates that a non-Ethernet connected tape drive is in this library location. 
For example, LTO2, LTO3. This field must be manually entered.

5. DMOD S/N

The serial number for the tape drive in this library slot.

6. Tray S/N

The serial number of the tray for the tape drive in this library slot.

Populating the Drive Definition Spreadsheet  The drive definition spreadsheet must include 
a populated row for each tape drive in the library. To populate the spreadsheet, do one 
of the following:

■ Specify library settings and click the Probe button.

■ If you enable the Auto-probe for drives option, you can enter an IP address in the 
spreadsheet and allow MD-VOP to probe for the drive. Once the drive is detected, 
the remaining columns are automatically populated.

■ Use configuration menu commands to select a range and probe for multiple IP 
addresses. Once IP addresses are detected, the spreadsheet columns are 
automatically populated.

See "Using Probe Commands" on page 8-9 for more information.

When you are finished entering tape drives on the spreadsheet, click the next empty 
row in the spreadsheet to signal to MD-VOP that the last row is complete. Then click 
the File menu and select Save to save your configuration.

Configuration Menus
The following configuration menus are displayed at the top of the Configuration 
screen:

■ "File Menu" on page 8-7

■ "Library Probe Operations Menu" on page 8-8

■ "Library Utilities Menu" on page 8-9

File Menu
The File menu includes the following commands:
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Open Configuration

Opens an existing configuration.

New Configuration

Creates a new, “empty” configuration with no libraries or tape drives. The current 
configuration is not affected.

Save

Saves the configuration.

Save as

Saves the configuration with a specified name.

Delete Configuration File

Deletes the configuration.

Set as Default Configuration

Sets the current configuration as the default configuration that is loaded when you 
start MD-VOP.

Unset Default Configuration

Clears the default configuration setting.

Launch

Launches an existing configuration. The five most recent configurations are listed.

Exit Configuration Dialog

Exits the Configuration screen.

Library Probe Operations Menu
Use the Library Probe Operations menu to populate tape drive information in the 
active library spreadsheet page.

This menu includes the following commands:

Probe IP Addresses in Spreadsheet

If an IP address is present in column 1, probe for a valid device.

Note: The auto probe routine (enabled by default) performs the same 
function. For valid IP addresses, the Drive Type and Drive Serial 
Numbers will be automatically populated. See "Tape Drive Settings" 
on page 8-6 for more information about the Auto-probe for drives 
routine.

Probe IP Range for Drives

Probes tape drives for a single library, based on an IP range. See "Probing an IP Range 
for Drives" on page 8-11.

Probe Library for Drives

Probes a library based on the specified library IP address and automatically populates 
the drive information in the Library Spreadsheet.

Probe Complex (SL8500 Only)
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Use the Library Probe Operations menu to direct MD-VOP to probe for a collection of 
SL8500 libraries connected with pass-through ports.

MD-VOP creates the libraries that can be detected from information reported by tape 
drives, and inserts the tape drives in the appropriate library.

This option is only valid for T10000 tape drives. These tape drives must be at 
appropriate firmware levels. See "MD-VOP Tape Drive Support" on page 3-3 for more 
information.

Note: This option is recommended only for new, “empty” 
configurations. Using this option with an existing configuration can 
result in mismatches and duplicate information.

See "Probing a Complex" on page 8-10 for information about performing the probe.

Library Utilities Menu
This menu includes the following commands:

Clear Spreadsheet

Clears all entries in the current drive definition spreadsheet. All entries are stored until 
you save the configuration.

Reset Probe Settings for this Library

Clears all entries in the current drive definition spreadsheet. All entries are stored until 
you save the configuration.

Retrieve Library SN

Clears all entries in the current drive definition spreadsheet. All entries are stored until 
you save the configuration.

Scan Tray Serial Numbers

Enables you to enter a serial number for a selected slot. This serial number is used 
when requesting support. It is included in reports, and in the information displayed 
when you mouse-over a tape drive.

This command loops through each tape drive present and requests that the tray serial 
number be added to the drive definition spreadsheet. For each slot, enter the serial 
number and press the OK button.

Note: You can also manually add these serial numbers to the drive 
definition spreadsheet.

Using Probe Commands
MD-VOP includes Probe commands designed to help you build an MD-VOP 
configuration. These commands probe for libraries and tape drives, and then create 
and populate the corresponding library spreadsheet pages.

Access these commands from the Library Probe Operations menu on the MD-VOP 
Configuration screen.
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Probing a Complex
Use the Library Probe Operations menu to direct MD-VOP to probe for a collection of 
SL8500 libraries connected with pass-through ports. MD-VOP creates the libraries that 
can be detected from information reported by tape drives, and inserts the tape drives 
in the appropriate library.

This option is only valid for T10000 tape drives. These tape drives must be at 
appropriate firmware levels.

Additionally, this option is recommended only for new, “empty” configurations. Using 
this option with an existing configuration can result in mismatches and duplicate 
information.

To probe an SL8500 library complex:

1. Click the Library Probe Operations menu and select Probe Complex (SL8500 
Only). A pop-up window appears:

Figure 8–3 Probe Complex for Libraries and Drive Location Dialog

2. Enter the Initial Tape Drive IP Address. Optionally, you may include the number 
of bits in the subnet mask. For example, 172.18.18.1/23.

3. Optionally, enter the number of bits in the subnet mask. This is an alternative to 
the method described in the previous step.

4. Enter the IP range count to scan from the base address. Click the Rest of Subnet 
button to automatically change the IP count to extend to the last IP address in the 
subnet.

5. Click the Probe button.

A status window appears as MD-VOP begins to probe each IP address in the 
specified range to locate any tape drives. During this process, MD-VOP scans the 
IP range, creates libraries, and places detected tape drives into the correct library 
and slot location.

If you want to cancel this operation, click the Abort Probe button at any time.

6. When the probe completes, an informational window appears, indicating the 
number of tape drives that were located and placed and the number of tape drives 
that were unable to be placed.

Note: You can manually enter the unsuccessful tape drives.



Using the MD-VOP Configuration Screen

Using MD-VOP Dashboard Menus 8-11

7. Click OK. MD-VOP creates a new tab in the Library Panel for each library 
detected. In addition, the drive definition spreadsheet for each library is 
automatically populated with the valid tape drive information.

Probing an IP Range for Drives
Use the Library Probe Operations menu to direct MD-VOP to probe for tape drive IP 
addresses within a selected library.

Click Library Probe Operations and select Probe IP Range for Drives. The following 
pop-up window appears:

Figure 8–4 Probe for Drive Location Dialog

This window includes options used to select one of the following probing methods:

■ Detect and Place Drive Manually

MD-VOP probes for tape drives and enables you to place them manually.

■ Place by Drive Library Location SL3000 and SL8500)

MD-VOP probes for tape drives and places them in the appropriate slots.

■ Sequential IP Drive Placement

MD-VOP probes for tape drives and places them sequentially by slot.

The following sections describe these methods.

Detect and Place Drive Manually  To perform the probe:

1. Click Library Probe Operations and select Probe IP Range for Drives. The Probe 
for Drive Location dialog box appears.

2. Click Detect and Place Drive Manually option.

3. In the Initial Tape Drive IP Address field, enter the starting IP address.

4. In the IP Range Count field, specify an IP Range Count or click the Rest of Subnet 
button to automatically change the IP count to extend to the last IP address in the 
subnet.
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5. Click the Probe button. MD-VOP scans the library and then the following screen 
appears:

Figure 8–5 Manual Drive Placement Screen

As shown in Figure 8–5, detected tape drives are listed on the left. Library slots are 
shown on the right.

You can use the following buttons to sort the list of detected tape drives:

■ Sort by IP

Sort the list of tape drives by IP address.

■ Sort by Type

Sort the list of tape drives by drive type.

■ Undo

Undo the last tape drive placement operation, returning the tape drive to the 
list of detected tape drives.

■ Skip

Skip the tape drive at the top of the detected drives list.

6. Click a slot to assign the first tape drive to the library.

7. Repeat Step 6 for the remaining tape drives in the list.

8. When you are finished, click Done. Otherwise, click Restart to clear your changes, 
or click Cancel to exit the operation.
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When you click Done, the drive information is added to the drive definition 
spreadsheet.

Place by Drive Library Location (SL3000 and SL8500)  To perform the probe:

1. Click Library Probe Operations and select Probe IP Range for Drives. The Probe 
for Drive Location dialog box appears.

2. Click the option for Place by Drive Location (SL3000 and SL8500).

3. In the Initial Tape Drive IP Address field, enter the starting IP address.

4. In the IP Range Count field, specify an IP Range Count or click the Rest of Subnet 
button to automatically change the IP count to extend to the last IP address in the 
subnet.

5. Click the Probe button. A progress window appears as MD-VOP begins to probe 
each IP address in the specified range to locate any tape drives. If you want to 
cancel this operation, click the Abort Probe button at any time.

6. When the probe completes, an informational window appears, indicating the 
number of tape drives that were located and placed and the number of tape drives 
that were unable to be placed. You have the option to manually enter the 
unsuccessful tape drives.

7. Click OK.

Sequential IP Drive Placement  To perform the probe:

1. Click Library Probe Operations and select Probe IP Range for Drives. The Probe 
for Drive Location dialog box appears.

2. Click the option for Sequential IP Drive Placement.

3. In the Initial Tape Drive IP Address field, enter the starting IP address.

4. In the IP Range Count field, specify an IP Range Count or click the Rest of Subnet 
button to automatically change the IP count to extend to the last IP address in the 
subnet.

5. Click the option for Sequential IP Drive Placement.

6. In the First Library Slot to Use field, enter the library slot number where counting 
is to begin.

7. Click the Probe button. A progress window appears as MD-VOP begins to probe 
each IP address in the specified range to locate any tape drives. Sequential IP 
addresses are placed starting at the slot you specified in Step 6. If you want to 
cancel this operation, click the Abort Probe button at any time.

8. When the probe completes, an informational window appears, indicating the 
number of tape drives that were located and placed and the number of tape drives 
that were unable to be placed. You have the option to manually enter the 
unsuccessful tape drives.

9. Click OK.

Library Probe  This routine enables you to detect devices from the library with a direct 
connection. Clicking the probe button does the same thing. This uses the library IP 
address that was entered.

To perform the probe:
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1. Click Library Probe Operations and select Probe IP Range for Drives. The Probe 
for Drive Location dialog box appears.

2. Click the option for Library Probe.

The following dialog appears:

Figure 8–6 Edit Probe Configuration

3. Enter your username and password and then click OK.

This routine may require several minutes to complete.

Using the MDVOP Server Menu Options
From the MD-VOP Dashboard, click the File menu and select MDVOP Server to 
display the MDVOP Server menu. This menu includes the following options:

■ Connect to Server

■ Create Client Configuration File from Server

■ Edit Domain Configuration File on Server

■ Delete Client Configuration File on Server

■ Launch Client Configuration

Connect to Server
Use this option to connect MDVOP to an MDVOP server.

1. From the MDVOP Server menu, select Connect to Server.

A Server Name dialog appears.

2. Enter the IP address for the MDVOP server and click OK.

MDVOP connects to the server.

Create Client Configuration File from Server
Use this option to create a new client configuration from an existing configuration on 
the MDVOP server. 

1. From the MDVOP Server menu, select Create Client Configuration File from 
Server.

A Server Name dialog appears.



Using the MDVOP Server Menu Options

Using MD-VOP Dashboard Menus 8-15

2. Enter the IP address for the MDVOP server from which you will select an existing 
configuration file.

A Remote File Chooser dialog appears, listing all available configuration files.

3. Select the desired configuration file and click OK.

The configuration file opens and you can save it as a new configuration file.

Edit Client Configuration File on Server
Use this option to edit a client configuration file on the MDVOP server.

1. From the MDVOP Server menu, select Edit Client Configuration File on Server.

A Remote File Chooser dialog appears, listing all available configuration files.

2. Select the configuration you want to edit and click OK.

The configuration page for the configuration you selected appears. As shown in 
Figure 8–7, this window includes a Configuration tab along with separate tabs for 
each library.

Figure 8–7 Client Configuration Page

3. Do one of the following: 

■ Click the Configuration tab to display the configuration page. You can click 
the Delete library button to delete a library.

■ Click a library tab to display the library page, listing all drives included in the 
library. You can click the "X" (delete) button next to a drive to delete it.

4. When you are finished with your edits, click the File menu and select Save to save 
the configuration. All changes are saved on the server side, and also locally.
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Edit Domain Configuration File on Server
Use this option to edit the domain configuration file (domain.vop), located on the 
server. This file defines which devices are monitored by the server. Only the services 
on the server use this file. The client uses a copy of this file called a client 
configuration.

1. From the MDVOP Server menu, select Edit Domain Configuration File on Server.

The domain.vop configuration page appears. As shown in Figure 8–8, this page 
includes a Configuration tab along with separate tabs for each library and VSM.

Figure 8–8 Domain.vop Configuration Page

2. Do one of the following:

■ Click the Configuration tab to display the configuration page. You can use this 
page to add or delete a library. Click the appropriate button.

■ Click a library tab to display the library page, listing all drives included in the 
library. You can do the following:.

– Edit the library name.

– Edit the IP address.

– Edit the serial number.

– Edit the ACS setting.

– Delete a drive. Click the "X" (delete) button next to a drive to delete it.

– Click the SNMP option to display the SNMP Configuration screen. Use 
this screen to enable SNMP for the selected library. This is required for 
ASR support, to allow communication from the device to the VOP server.



Changing MD-VOP Default Settings

Using MD-VOP Dashboard Menus 8-17

Enter the IP address of the port that the library is attached to on the server, 
select Enable SNMP for this library and click OK. The server will begin 
listening for these libraries.

■ Click a VSM tab to display the VSM page, used to discover the VSM.

Enter a VSM name and IP address and click Discover. Once the VSM is 
discovered, the VSM Information fields are automatically populated and the 
VSM is automatically configured.

3. When you are finished with your edits, click the File menu and select Save to save 
the configuration.

4. Restart server services.

Delete Client Configuration File on Server
Use this option to delete a client configuration file on the server.

1. From the MDVOP Server menu, select Delete Client Configuration File on Server.

A File Chooser dialog appears, listing all client configuration files.

2. Select the configuration file you want to delete and click OK. 

The configuration is deleted.

Launch Client Configuration
Use this option to launch an existing client configuration.

Changing MD-VOP Default Settings
From the MD-VOP Dashboard, click the File menu and select Default Settings to 
access the Default Settings screen. Use this screen to change the default MD-VOP 
display settings.

Figure 8–9 shows the MD-VOP Default Settings screen:

Figure 8–9 MD-VOP Default Settings Screen
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As shown in Figure 8–9, this screen includes the following tabs:

■ "Misc Display Settings" on page 8-18

■ "Drive State Display Settings" on page 8-18

■ "Encryption Display Settings" on page 8-20

■ "Drive Health Display Settings" on page 8-21

Use these tabs to customize your MD-VOP display options. Click a tab to make it 
active.

Additionally, this screen includes the following buttons:

Restore Defaults

Restores default settings.

Save

Saves current settings.

Cancel

Cancels the operation.

Note: These buttons apply to all tabs.

Misc Display Settings
Click this tab to view or edit general display settings.

As shown in Figure 8–9. This tab includes the following settings:

Encryption View

Click options to enable or disable the Encryption tab and Encryption menu items in 
the MD-VOP main interface.

Drives Viewpoint

Click options to specify whether the library view displays tape drives as if viewing 
from the front (inside) or back (outside) of the library.

Save and Restore Transcripts

Click one of the following options to specify transcript settings:

■ No Save/Restore

Do not save transcripts. This is the default.

■ Default Save/Restore

Save transcripts in user directory /.mdvop/transcript.

■ Local

Specify a new location where transcripts are saved.

Drive State Display Settings
Click this tab to view or edit drive state display settings.
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Figure 8–10 Drive State Display Settings

As shown in Figure 8–10, the Drive State Display Settings tab includes the following:

■ "Icon Label Settings" on page 8-19

■ "Icon Color Settings" on page 8-20

Icon Label Settings
In MD-VOP, each tape drive icon includes three label fields that can display different 
drive attributes.

For each label (1-3), click one of the following options to define the attribute to be 
displayed on the icon:

ACSLS Location

Display the location in ACSLS

Nothing

Display nothing.

Drive Type

Display the drive type.

Drive Name
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Display the drive name assigned on the Configuration screen.

Volser

Display the volume serial number if a standard label tape cartridge is loaded.

Firmware Level

Displays the firmware in the tape drive.

Icon Color Settings
Additionally, this tab enables you to change the color setting and icon label for each 
drive state icon:

Drive state display

For each drive state, click the check box in the icon to show or hide the default display 
for that drive state.

Color motif

Click the options to select a light or dark color motif.

Icon color

Enter an RGB value in the dialog box, or click more colors to choose from a palette.

Icon label

Enter label text in the dialog box. This text is displayed beneath the icon in the Library 
Panel legend.

Encryption Display Settings
Click this tab to view or edit encryption display settings.
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Figure 8–11 Encryption Display Settings

This tab shares the same options as the Drive State tab. See "Drive State Display 
Settings" on page 8-18.

Drive Health Display Settings
Click this tab to view or edit encryption display settings.



Changing MD-VOP Default Settings

8-22 Oracle Virtual Operator Panel 2.2 User’s Guide

Figure 8–12 Drive Health Display Settings

This tab shares the same options as the Drive State tab. See "Drive State Display 
Settings" on page 8-18.
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9Using MD-VOP Library Panel Menus 

This chapter describes how to use the MD-VOP Library Panel menus.

Use MD-VOP menu commands to perform functions on one or more selected tape 
drives.

The Library Panel includes the following menus:

■ File Menu

■ Drive Operations Menu

■ Retrieve Menu

■ Configuration Menu

■ Encryption Menu

■ Reports Menu

Note: Depending on your access level, some menus may not be 
displayed.

File Menu
The File menu includes the following commands:

Reconnect to Selected Drives in This Library

MD-VOP attempts to reconnect to the selected tape drives in the library. Use this 
function after a network or tape drive issue is encountered.

Reconnect to Unconnected Drives

MD-VOP attempts to reconnect to those tape drives with a failed network connection.

Refresh Icons in the Library

Refreshes tape drive icons to the last known state.

Clear Library Transcript

Clears the current library transcript (log).

Clear All Drive Transcripts

Clears all tape drive transcripts (logs) for the selected library
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Drive Operations Menu
The Drive Operations menu includes the following commands, used to control the 
function of one or more selected tape drives. These commands may have disruptive 
consequences. Therefore, you are prompted to continue before a command is executed.

Note: Online, offline, load, and IPL stop all active backup jobs to the 
selected libraries.

Health Analysis of Selected Drives in This Library

Performs a health check on selected tape drives. To view the results of this analysis, 
click the Drive Health View tab in the MD-VOP Library Panel. See "Drive Health 
View" on page 7-12 for more information. The Health Analysis does not affect drive 
functionality.

Set Selected Drives Online in This Library

Places selected tape drives in online state. This is the normal operational state.

Set Selected Drives Offline in This Library

Places selected tape drives in offline state. This state is designed for tape drive 
maintenance.

Load Tape Cartridges in This Library

Loads selected tape drives. A tape cartridge must be inserted in the tape drive, but not 
loaded.

Unload Tape Cartridges in This Library

Unloads selected tape drives. The tape cartridge is dismounted. The tape remains in 
the tape drive, but is not threaded.

IPL Selected Drives in This Library

Performs an IPL (Initial Power Load) of the selected tape drives. An IPL can result in 
the following:

■ During an IPL, the tape drive is reported as not available to MD-VOP

■ If a tape is present, the tape drive unloads the tape.

■ If a tape is present, it may have an invalid MIR (degraded high speed access).

■ Any I/O on the data path stops. Depending on the backup/archive application, 
the tape drive may require several minutes to recover.

Retrieve Menu
The Retrieve menu includes the following commands, used to obtain or remove logs 
from selected tape drives. These commands are non-disruptive.

Note: This menu is only available in the system administrator 
version of MD-VOP

Retrieve ID Files in This Library

Retrieves a file that contains information about the global functioning of the selected 
tape drives.
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Retrieve Dump Logs in This Library

Retrieves a memory dump that contains the full state of the selected tape drives at the 
moment. A dump is a SNO (Should Not Occur) meaning that the firmware detected a 
state that could not be addressed.

Retrieve Event Logs in This Library

Retrieves a log that contains the Fault System Codes (FSC) and events for the selected 
tape drives.

Retrieve Perm Logs in This Library

Retrieves a log containing non-dump events.

Retrieve All Logs in This Library

Retrieves all logs for the selected library based on the library IP address.

Delete Dump Logs in This Library

Deletes the dump logs from the selected tape drives.

Delete Event Logs in This Library

Deletes the event logs from the selected tape drives.

Delete Perm Logs in This Library

Deletes the perm logs from the selected tape drives.

Delete All Logs in This Library

Deletes all logs from the selected tape drives.

Note: It is recommended that you save logs before deleting them, as 
they can help in troubleshooting tape drive issues.

Configuration Menu
The Configuration menu includes the following commands, used to configure the time 
on all selected tape drives in the library and load firmware from a file to the tape 
drives.

Note: This menu is only available in the system administrator 
version of MD-VOP.

Set Clocks in This Library

Synchronizes time on the tape drives with that of the server. This is a non-disruptive 
operation.

Firmware Update from File in This Library

Loads firmware from a user-specified file to a tape drive. See "Performing a Firmware 
Update" on page 9-3.

Performing a Firmware Update
Before loading firmware from a file, consider the following:
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■ Do not IPL (reboot) a tape drive during a firmware update. Doing so can 
potentially cause the tape drive to become unusable.

■ Only T10000, T9840D, and LTO 4 tape drives may be updated through the 
network interface.

■ The tape drives you select for a firmware update must be of the same drive type.

■ The tape drive checks the file being transferred and disregards firmware files that 
are not valid for that tape drive.

■ You can load up-level or down-level firmware, without the dependencies of 
intermediate firmware.

■ When the Code Load from File screen is displayed, the MD-VOP main interface is 
still visible and selectable, depending on the operating system. The interface will 
update, however, the menu items are disabled.

■ You must manually check a T9840D to be offline before performing a firmware 
update. Otherwise, the tape drive will immediately display a failed indication in 
the firmware display.

■ Firmware updates may fail, depending on network and other conditions. Once a 
firmware update completes, always check the selected tape drives to verify that 
the firmware was transferred successfully.

Loading Firmware from a File to a Tape Drive
To load firmware, do the following:

1. Select one or more tape drives that are to receive new firmware. The tape drives 
you select must be of the same drive type.

2. Click the Drive Operations menu and select Set Selected Drives Offline.

3. Click the Configure menu and select Firmware Update from File in This Library. 
A Code Load from File screen appears.

4. Locate and click the firmware file, and click the Open button.

5. Click the Update button. The Firmware Update Progress dialog box appears, 
displaying the tape drives that are selected for a firmware update.
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Figure 9–1 Firmware Update Process Dialog

6. Click an option to select one of the following Concurrent Updates settings:

All

Update all selected tape drives simultaneously.

4/8

Update the selected tape drives in groups of four or eight, one group at a time.

Custom

Specify the number of tape drives to be updated simultaneously, before the next 
group is updated.

7. Click the Update button to begin transferring the firmware to the selected tape 
drives. The legend displays the results of each step of the process:

Not Started

The firmware update has not started.

Firmware Download

The firmware is transferring to the tape drive.



Encryption Menu

9-6 Oracle Virtual Operator Panel 2.2 User’s Guide

Firmware Reprogram (firmware update process has started)

The firmware process has started.

IPL

The tape drive has rebooted.

Update Successful

The Firmware update succeeded.

Update Failed

The firmware update failed.

Encryption Menu
The Encryption menu includes commands used to control mass encryption routines 
for tape drives in the selected library. This menu is only supported for Windows and 
Solaris operating systems.

Note: By default, the Encryption view is not displayed, unless you 
indicated to include it when you installed MD-VOP. You can activate 
this view using the MD-VOP Default Settings screen. See "Changing 
MD-VOP Default Settings" on page 8-17 for more information.

The Encryption menu includes the following commands:

Note: Before using these commands, you must complete the tasks 
described in "Encryption Command Requirements" on page 9-7.

Create OKM Agents in the Library

Using the DMOD numbers of the selected tape drives, MD-VOP locates the entry in 
the spreadsheet and uses the information to create an OKM agent. Tape drives are not 
affected.

Modify OKM Agents in the Library

Using the DMOD numbers of the selected tape drives, MD-VOP locates the entry in 
the spreadsheet and uses the information to modify the existing OKM agent. Tape 
Drives are not affected.

Enroll Drives in This Library

Using the DMOD numbers of the selected tape drives, MD-VOP locates the entry in 
the spreadsheet, and uses the information to enroll the tape drives. The following 
actions occur:

1. MD-VOP interrogates selected tape drives to ensure that they meet entry 
conditions (for example, offline, unloaded, and unenrolled).

2. MD-VOP interrogates the OKM to ensure that all agents meet entry conditions.

3. MD-VOP enrolls the tape drives with OKM.

4. MD-VOP interrogates the OKM to ensure that all agents are in the enrolled state.

Unenroll Drives in This Library
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Using the DMOD numbers of the selected tape drives, MD-VOP locates the entry in 
the spreadsheet, and uses the information to unenroll the tape drives. The following 
actions occur:

1. MD-VOP interrogates selected tape drives to ensure that they meet entry 
conditions (for example, offline, unloaded, and unenrolled).

2. MD-VOP interrogates the OKM to ensure that all agents meet entry conditions.

3. MD-VOP resets the tape drives.

4. MD-VOP sets the agents to unenrolled on the OKM.

Set Drives to Unencrypting in This Library

Unenrolls the tape drives from OKM.

Compare OKM, Spreadsheet, and Drives in This Library

Verifies that the OKM, spreadsheet, and tape drives are synchronized. Tape Drives are 
not affected.

Create Spreadsheet Template

Creates a spreadsheet template with drive fields populated for the selected tape 
drives. You must manually enter agent information.

Create Spreadsheet Template with Agent Lookup

Creates a spreadsheet template with drive fields populated for the selected tape 
drives. Agent information (except for passphrase) is populated with information 
retrieved from OKM.

License Drives in This Library

Performs license operation to enable encryption on multiple tape drives in parallel.

Encryption Command Requirements
With exception of the License Drives in This Library command, Encryption menu 
commands require the following inputs before they can be issued:

■ You must select the tape drives on which to perform the command operation.

■ You are prompted to identify the tab-delimited .txt file or the encrypted .ect file 
that contains all of the drive and agent information. This information is used to 
exchange information with the security officer who controls OKM and the 
MD-VOP.

■ You are prompted to select the directory that contains the certificates obtained 
previously from Oracle Key Manager (OKM).

OKM Data File
You must create a tab-delimited (.txt) file that includes the required information to 
correlate OKM data with the intended tape drives. Use any spreadsheet program to 
create this tab-delimited file.

Note: In most spreadsheet programs, default cell format settings 
cause the DMOD (tape drive serial number) to be displayed in 
scientific notation. To correct this, set the format to text.

Required Columns  You must include the following columns in the OKM data file:
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■ DMOD

■ Tape drive serial number

■ Key Group

■ OKM Agent ID

■ Passphrase

■ OKM Agent passphrase

■ OKM IP

■ IP address of the OKM attached to the tape drive

Optional Columns  Optionally, you can include the following additional columns in the 
OKM data file:

■ OKM Site ID

■ Description of the OKM site server

■ Description

■ Description of the tape drive

■ Slot Number

■ Library location of the tape drive

■ Drive IP

■ IP address (IPV4) of the tape drive

■ Drive family type

■ Type of tape drive

Retrieving Certificate files from OKM
Before using the MD-VOP encryption commands, you must obtain the CA certificate 
and Client certificate files from OKM.

1. Launch the OKM GUI (version 2.3 or later).

2. Connect to OKM in the Operator role.

3. In the OKM GUI, click the System menu and select Save Certificates. The Save 
Certificates dialog box appears.
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Figure 9–2 OKM Save Certificates Dialog

4. Enter the location on the MD-VOP host where certificates are to be stored. You 
must enter both the CA Certificate File Name and Client Certificate File Name.

5. Click the OK button to retrieve the certificate files from OKM.

Reports Menu
The Reports menu includes the following commands, used to generate reports that 
describe the state of one or more tape drives. When you select one of these commands, 
MD-VOP prompts you for a location to save the report file.

Note: This menu is only available in the system administrator 
version of MD-VOP

Drive Status Report

Generates a report that provides general status information for all tape drives in the 
library

Encryption Report

Generates a report that provides information about the encryption settings for all tape 
drives in the library.

Health Report

Generates a report that provides information about the health of all tape drives in the 
library. A separate report file is created for each selected tape drive.

ASR Report

Generates a report that provides ASR status information including a summary of 
activation and any alerts sent.
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10Using T10000 9840D VOP 

This chapter describes how to use the T10000 9840D Virtual Operator Panel (VOP) 
with a single T10000 or T9840D tape drive.

Designed for ease of use, the T10000 9840D VOP Graphical User Interface (GUI) 
enables you to do the following:

■ Monitor tape drive status

■ View or change tape drive configuration settings

■ Perform tape drive operation utilities

T10000 9840D VOP Interface
Figure 10–1 shows the T10000 9840D VOP main interface:

Figure 10–1 T10000 9840D VOP Interface

Legend:

1. Menus

2. Drive IP

3. Primary and Secondary Message Windows

4. Status Indicators

5. Transcript Pane
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As shown in Figure 10–1, the T10000 9840D VOP interface includes the following:

■ Menus

Use menus to issue T10000 9840D VOP commands. See “"Using T10000 9840D 
VOP Menus" on page 10-2 for more information.

■ Drive IP

Displays the IP address of the tape drive loaded.

■ Primary and Secondary Message Windows

Display status messages during T10000 9840D VOP processing.

■ Tape Drive Status Indicators

These indicators show the current drive state:

– The Empty/Loaded status indicator indicates whether a tape cartridge is 
loaded in the tape drive. When you load a cartridge in the tape drive, this 
status indicator changes from gray to blue, and indicates Loaded.

– The Online/Offline status indicator indicates whether the Ethernet adapter 
card is online. When you bring a tape drive online, this status indicator 
changes from gray to blue, and indicates Online.

– The Clean status indicator indicates that the tape drive must be cleaned.

– The Dump status indicator indicates that a dump is present for retrieval.

– The Enabled/Unlicensed status indicator indicates whether the tape drive is 
encrypted.

* When a tape drive is encrypted and has all keys, the status indicator is 
orange, and indicates Enabled.

* When a tape drive is missing an encryption key or has not been enrolled, 
the status indicator is red and indicates Unlicensed.

Note: You can click directly on certain status indicators to toggle the 
state of the monitored drive item.

■ Transcript Pane

Displays a transcript of T10000 9840D VOP actions and prompts for additional 
input or actions.

Using T10000 9840D VOP Menus
T10000 9840D VOP includes the following menus:

■ File Menu

■ Drive Operations Menu

■ Retrieve Menu

■ Configure Menu

■ Help Menu

Depending on your access level, some menus may not be displayed. Also, certain 
menus require the tape drive to be offline.
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File Menu
To open the File menu, click File in the menu bar or use the ALT+F keyboard shortcut. 
File menu commands are available when the tape drive is either online or offline.

The File menu includes the following commands:

Clear Transcript

Clears the entire T10000 9840D VOP transcript pane and closes the file menu.

Connect to Drive

Connects T10000 9840D VOP to the tape drive.

When the authentication dialog box appears, enter the tape drive IP address and click 
OK.

Note: Optionally, you can use the SHIFT+C keyboard shortcut from 
the File menu to issue this command.

Collect Support Logs

Collects tape drive log files that you can forward to product support for analysis.

A text pane message appears after each log is collected, and a final message indicates 
the location of the archive (zip) message file.

Note: Optionally, you can use the SHIFT+S keyboard shortcut from 
the File menu to issue this command.

Exit

Disconnects T10000 9840D VOP from the tape drive and closes the application. Allow 
a few seconds for the shutdown operation to complete.

Drive Operations Menu
To open the Drive Operations menu, click Drive Operations in the menu bar or use 
the ALT+D keyboard shortcut.

Refer to the T10000 Tape Drive Operator’s Guide and the T9840 Tape Drive User’s 
Reference Manual for additional information regarding the tape drive, use of a cartridge 
tape, and general operating procedures.

The Drive Operations menu includes the following commands:

Note: The tape drive must be encryption-enabled for some 
commands to appear.

Load Tape

Loads a cartridge that is presently in the cartridge loading slot. A text pane message 
indicates that the tape cartridge is loaded.

Note: Optionally, you can use the SHIFT+L keyboard shortcut to 
issue this command from the Drive Operations menu.
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Unload Tape

Rewinds and unloads a loaded cartridge. A text pane message indicates that the tape 
cartridge is unloaded.

You must physically remove an unloaded cartridge from the tape drive by library 
robotics, or manually, from the rack mount configuration. Otherwise, the cartridge 
remains in the loading slot but is not loaded in the tape drive.

Note: Optionally, you can use the SHIFT+U keyboard shortcut to 
issue this command from the Drive Operations menu.

Set Offline or Set Online

Changes the tape drive state.

■ When the tape drive is online, this command indicates Set Offline.

■ When the tape drive is offline, this command indicates Set Online.

You can also click the Online/Offline indicator to change the tape drive state.

Note: Optionally, you can use the SHIFT+O keyboard shortcut to 
issue this command from the Drive Operations menu.

IPL Drive

Performs a tape drive initial program load (IPL). If the tape drive is online, a 
confirmation dialog box appears.

During the IPL, VOP loses communication with the tape drive. Once the IPL is 
successfully completed, VOP automatically reconnects with the tape drive.

Force Dump

Dumps the current contents of various drive registers to a file.

The tape drive stores the dump to internal memory, and the dump status indicator 
changes to orange. The forced dump operation causes a tape drive IPL, during which 
VOP loses connection with the tape drive. Once the IPL is successfully completed, 
FFFA appears in the secondary drive message window.

Format Tape

Launches the Format Tape Cartridge dialog box you can use to run the following 
formatting utilities:

■ Make data tape

■ Make code tape

■ Make dump tape

■ Rebuild MIR

See "Using the Format Tape Command" on page 10-5 for information about these 
utilities and how to run them.

Identify Drive On

Causes the Drive Status indicator on the rear panel of the tape drive to flash.

■ On a T10000A/B tape drive, the indicator uses a fast flash rate
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■ On a T10000C tape drive, the indicator changes color between green and blue.

The indicator flashes for five minutes.

Identify Drives Off

Stops an Identify Drive On command, and the Drive Status indicator returns to the 
previous state.

Set Power Hibernate (T10000C tape drives only)

Forces the T10000C tape drive into the hibernation state. The status indicator to the 
right of the Dump indicator turns gray and indicates Hibernate.

Set Power Active (T10000C tape drives only)

Forces the T10000C tape drive out of the hibernation state. The status indicator to the 
right of the Dump indicator turns blue and indicates Active.

Note: It takes approximately 20 seconds for the tape drive to wake 
from the hibernation state.

Using the Format Tape Command
To Format a Tape Cartridge:

1. Make sure the tape drive is offline.

Use one of the following methods to set the tape drive offline:

■ Click the Online status indicator.

■ Open the Drive Operations menu and click the Set Offline command.

■ Use the keyboard shortcut ALT+D to open the Drive Operations menu, 
followed by SHIFT+O to set the drive offline.

2. Click the Drive Operations menu and select Format Tape. The Format Tape 
Cartridge dialog box appears.

3. Select the utility you want to run:

■ Make data tape

This utility reformats a tape cartridge for resuse as a data tape cartridge. 
Existing headers are removed and the Media Information Region (MIR) is 
rewritten to identify the cartridge as empty, and therefore ready for write 
operations.

■ Make code tape

This utility reformats a tape cartridge in a special format, and downloads the 
tape drive firmware from tape drive memory to the tape cartridge. The MIR is 
then written to identify the cartridge as a code tape. You can use the code tape 
to upload tape drive firmware to other tape drives.

■ Make dump tape

This utility reformats a tape cartridge in a special format. The MIR is written 
to identify the cartridge as a dump trace. You can use a formatted dump tape 
to download diagnostic dump data from drive memory.

■ Rebuild MIR

Use this utility to rebuild a data tape cartridge that has an invalid or corrupted 
MIR. The utility reads the file headers to the end of the Data mark. Then, the 
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MIR is rewritten to correctly reflect the tape contents. This utility can take over 
one hour to rebuild the MIR on a full or nearly full data cartridge. Refer to the 
StorageTek T10000 Tape Drive Operator’s Guide for more information about MIR.

4. Click the Make button or use the ALT+M keyboard shortcut to run the selected 
utility.

A prompt appears in the transcript pane, directing you to insert a cartridge. If 
there is a cartridge in the tape drive, it unloads. You must physically remove the 
cartridge.

Note: Before inserting the cartridge, you can cancel the selected 
utility by clicking the ABORT button or using the ALT+A keyboard 
shortcut. Once the cartridge is inserted, the utility runs to completion.

Caution: Do not use the Make Code Tape or Make Dump Trace 
functions with a customer data tape.

5. Insert a write-enabled cartridge.

Make sure the cartridge’s write protect switch is in the write-enabled position as 
indicated by the open padlock icon shown in Figure 10–2.

Figure 10–2 Tape Cartridge Write Protect Switch

Legend:

1. Write Protect Switch

2. Unlocked (Write Enabled) Position

3. Locked Position

When you insert a cartridge, the tape drive performs the selected utility, displays 
related information in the VOP transcript pane, and then unloads the cartridge.

6. Remove the unloaded cartridge.
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7. Click the DONE button to exit.

Retrieve Menu
To open the Retrieve menu, click Retrieve in the menu bar or use the ALT+R keyboard 
shortcut.

The Retrieve menu includes the following commands:

View Drive Data

This command opens the View Current Drive Settings dialog box. Use the tabs in this 
dialog box to view current tape drive configuration settings and other tape drive data. 
When you’re finished, click OK or use the ALT+O keyboard shortcut to close the 
dialog box.

This command is only available when the tape drive is offline.

Use this command for viewing purposes only. To change current tape drive settings, 
use the Configuration menu. See "Configure Menu" on page 10-8.

Note: Optionally, you can use the SHIFT+V keyboard shortcut to 
issue this command from the Retrieve menu.

The View Current Drive Settings dialog box includes the following tabs:

■ Encrypt (encryption-capable tape drive)

Displays encryption related data.

For additional information on FIPS aspects of the tape drive, refer to the following 
publications:

– T10000A Encrypting Tape Drive Security Policy

– T10000B Encrypting Tape Drive Security Policy

– T10000C Encrypting Tape Drive Security Policy

■ Fibre

Displays information specific to the tape drive interface.

■ Keyid (encryption-capable tape drive)

Displays a list of key identifiers.

■ Maintenance

Displays maintenance settings and whether they are enabled.

■ Manufacturing

Displays factory preset settings, including drive serial number, and default world 
wide names.

■ Missing (encryption-capable tape drive)

Displays a list of missing key identifiers.

■ Network

Displays a network node name. The factory preset default is composed of the tape 
drive model number, T10000 for example, and the last nine digits of the tape drive 
serial number.
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This tab also displays the current static IP settings.

■ Power

Displays current delay time setting for automatic hibernation, and whether 
hibernation is enabled for the T10000C tape drive.

■ Rfid

Displays data stored in the radio-frequency identification (Rfid) memory chip in 
the T10000 tape cartridge. The Rfid chip stores data related to cartridge contents 
and statistics. This data is similar to data stored in the media information region 
(MIR) on the tape, and is updated with each cartridge mount/dismount. An Rfid 
module in the tape drive reads the Rfid chip while the cartridge is loaded, and is 
viewable (read-only) by the VOP application.

■ Version

Displays tape drive-specific firmware and hardware levels.

■ View Date & Time

Displays an entry for the tape drive’s internal timer setting in the VOP transcript 
pane. For example:

8:55 AM Aug 2, 2010 - VOP LOGGED IN to Drive

8:59 AM Aug 2, 2010 - Tape Drive Clock set to 07/30/2010 11 
11:52:44:670

Notice the tape drive clock setting (8:59) is behind the VOP time on the same text 
line. The tape drive clock only operates while the tape drive is powered.

Therefore, when the tape drive is not powered, the tape drive clock time can fall 
behind real clock time. Most library configurations set the drive clock to be 
synchronized with the library clock.

■ ID File to File

Retrieves and saves the ID file to the ID folder in the VOP directory.

■ Dumps to File

Retrieves diagnostic dumps that are currently stored in the drive memory, and 
enables you to save the dumps in a specified location. After you save the dump 
file, an entry is displayed in the VOP transcript pane. For example:

9:00 AM Aug 2, 2010 - Dumps RETRIEVED to D:\T10B_dump_aug2

8:55 AM Aug 2, 2010 - DUMP AVAILABLE: fffa:DMP 1

9:00 AM Aug 2, 2010 - Retrieve Dumps in Progress

■ Perms to File

Retrieves all the permanent errors that are currently stored in the drive memory, 
and enables you to save the error log in a specified location.

■ Logs to File

Retrieves event logs that are currently stored in the drive memory, and enables 
you to save the event logs in a specified location.

Configure Menu
To open the Configure menu, click Configure in the menu bar or use the ALT+C 
keyboard shortcut.



Using T10000 9840D VOP Menus

Using T10000 9840D VOP 10-9

The Configure menu includes commands used to change and save configuration 
settings, set the time on a tape drive, and load firmware from a file or tape.

Note: With the exception of the Set Clock command, these 
commands are only available when the tape drive is offline. The tape 
drive should not be available to the host when you exercise any 
change that results in the tape drive performing an Initial Program 
Load (IPL) to implement the configuration change.

The Configure menu includes the following commands:

Drive Data

This command opens the Configure Drive Parameters dialog box. Use this dialog box 
to change and save your configuration settings. See "Configuring Drive Data" on 
page 10-9 for more information.

Note: Optionally, you can use the SHIFT+D keyboard shortcut to 
issue this command from the Configure menu.

Save Drive Config

Saves the current tape drive configuration settings to a file. You can retrieve the saved 
file to restore configuration settings.

Set Clock

Sets the tape drive’s internal clock to the current time in your computer. Once the clock 
is set, an entry is displayed in the VOP transcript pane.

Firmware Update from File

Loads firmware from a user-specified file to a tape drive.

Firmware Update from Tape

Loads firmware from a pre-recorded code tape (cartridge) to a tape drive.

During the update process, you are prompted to insert and remove the code tape 
cartridge containing the proper firmware release firmware level. When the update is 
complete, use the Version tab in the Retrieve menu to confirm the updated firmware 
level.

Configuring Drive Data
Click the Configure menu and select the Drive Data command to display the 
Configure Drive Parameters dialog box.

Note: This command is only available when the tape drive is offline.

Use the tabs in this dialog box to access different configuration settings. Each tab 
includes fields to specify configuration settings, and buttons to perform related 
operations.

To change a setting, enter a new value in a field. The accompanying Update check box 
is automatically selected to indicate a change.

Once you have made your changes, do either of the following:
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■ Click the Commit button or use the ALT+C keyboard shortcut to commit your 
changes.

If you decide against a value entered, uncheck the Update box and the Commit 
operation ignores it.

■ Click the Cancel button or use the ALT+N keyboard shortcut to cancel all pending 
changes.

Tabs  The Configure Drive Parameters dialog box includes the following tabs:

Encrypt

Use this tab to change tape drive encryption characteristics and enrollment 
information.

■ Refer to the Oracle Key Manager Administration Guide for information about the use 
of Oracle Key Manager (OKM).

■ Refer to your StorageTek T10000 tape drive publications for information about the 
use of Data Path Key Management (DPKM) and FIPS aspect of the tape drive.

Fibre

Use this tab to change tape drive-specific Fibre Channel configuration settings.

Network

Use this tab to change network configuration settings, including the IPv4 address and 
network node name.

Note: These settings are preset during manufacturing, and should 
only be changed at the direction of your IT manager.

■ To change the static IPv4 address, enter new values for IP address, Subnet mask, 
and Gateway, and click the Commit button.

Each parameter consists of four, three digit groups. For example:

010.000.000.001

For each three-digit group, you can enter a value from 000 to 255.

Note: If your tape drive is monitored by a Service Delivery Platform 
(SDP), the SDP incorporates a dynamic host control protocol (DHCP) 
server that assigns a dynamic IP address to the tape drive.

■ To change the network node name, overwrite the existing value and click the 
Commit button.

The factory preset network node name for a T10000 tape drive is:

t10000-<last nine digits of drive serial number>

Power (T10000C only)

Use this tab to enable/disable auto hibernation and specify the auto hibernation delay 
time, from 0 to 60 minutes.

T10000C auto hibernation is designed to save power when a cartridge has not been 
mounted for a specified time period. Normally, the library monitors whether a tape 
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drive is hibernating and directs a tape drive to wake up whenever a mount is about to 
occur.

Security (T10000C only)

Use this tab set or change the tape drive password.

To change your password, enter the current password and new password, reenter the 
new password, and then click the Commit button.

Note: If the tape drive password has not previously been changed, 
enter default for the current password.

New passwords must be 8-16 characters, and must include each of the following 
character types:

■ Upper case character

■ Lower case character

■ Number

■ Special character

Note: ! @ # $ % ^ & * ( ) { } { } + = - _ are valid special characters.

Buttons  The Configure Drive Parameters dialog box includes the following buttons:

Load Drive Config

Click this button or use the ALT+L keyboard shortcut to import a previously saved 
configuration file. After the imported file is opened, all tabs are populated with the 
saved configuration settings. Marked Update check boxes identify changed settings.

Make any necessary changes to settings, and then click the Commit button or use the 
ALT+C keyboard shortcut to save your settings.

Note: The imported configuration file includes parameters specific to 
the originating tape drive. Be sure to clear or reset tape drive-specific 
parameters to accurately reflect the tape drive that imported the saved 
configuration file.

Commit

Click this button or use the ALT+C keyboard shortcut to initiate an IPL to save and 
activate all pending changes. When you click the Commit button, only those fields 
with an active check box are updated.

During the commit process, VOP loses connection to the tape drive when IPL begins. 
However, VOP automatically reconnects to the tape drive after successful IPL.

Click this button to save the configuration settings in NVRAM. The Ethernet card 
reboots when you change an IP setting.

Cancel

Click this button or use the ALT+N keyboard shortcut to unselect all pending setting 
changes.
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Drive Data Settings  The following describes the general tape drive data settings 
included in the Configure Drive Parameters dialog box.

Note: Additional settings may be displayed, depending on drive 
type and firmware levels.

Emulation

Available emulation options are dependent on the active interface, tape drive model, 
and firmware version.

Data Compression

The following describes data compression options:

Note: The option defaults to the last saved selection.

■ No

Data is not compressed. but can be overridden by the host for a job.

■ Yes

Data is compressed, but can be overridden by the host for a job. This is the factory 
default setting.

■ Off

Data compression is disabled, and cannot be overridden by the host.

Data Security Erase

The following describes data security erase options:

■ Yes

Enables a full data security erase. A random binary pattern is written on the 
media, over-writing existing data, from the point of an “Erase” command to the 
End of Tape mark. This is the factory default.

■ No

Writes an end of tape mark on the media that indicates valid data does not exist 
beyond the point of an “Erase” command. Data is actually still present beyond the 
end of data mark, and it can be retrieved by special tape utilities.

Standard Label Protect

The following describes standard label protect options:

■ Yes

Enables standard label protection.

– Select Yes if label overwrite code is loaded, or if running standard labels and 
want the tape drive to display an irrecoverable error (CHK 33EX) when 
writing a non-80-byte record for VOLSER or HDR1.

– POST WRCART cannot be run with Yes selected.

■ No

Disables standard label protection. This is the factory default.
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Select No if you are using NL or NSL tape processing.

Library Address

The library address text field contains a two-character hexadecimal value set to ff at 
the factory.

This setting should remain at ff for all libraries except for the 9310 Powderhorn library, 
where the address is keyed to the drive cabinet position, as viewed from the cabinet 
rear.

Valid entries for the 9310 Powderhorn Library 9741/9741E drive cabinet are 00-09 (top, 
down), left column; and 0A-13 (top, down) right column.

Tape Completion Display

This setting determines whether tape completion percentages are displayed in the 
SDVOP secondary window when a tape cartridge is loaded in the tape drive.

This display is superseded by higher priority messages that display in the SDVOP 
secondary window.

■ Yes

Tape completion percentages are displayed.

■ No

Tape completion percentages are not displayed.

Language

This setting specifies the language in which certain operational messages (for example, 
loading, unloading.) appear in the SDVOP drive message windows. The following 
languages are supported:

■ English (the default)

■ Espanol

■ Francais

■ Italiano

■ Deutsch

World Wide Name

Caution: Indiscriminately changing the WWN could result in the 
tape drive being unavailable to the host.

The World Wide Name (WWN) identifies the tape drive node. This string of 16 
hexadecimal characters represents a 64-bit, unique identifier that distinguishes the 
individual tape drive from all other devices worldwide. Characters 2 through 6 
identify the specific manufacturer. Oracle StorageTek branded devices have the 
company ID “00104F”. Other characters reveal additional tape drive-specific 
information.

The custom label indicates that a customized WWN is active.

The (default) label indicates that the WWN was preset at the factory. For example:

World Wide Name(default): 50:01:04:f0:00:93:c6:9d
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Manufacturing assigns a block of three WWNs (from a pool of company-specific 
WWNs) to each tape drive during the manufacturing process. One for the tape drive 
and one each for the two fiber-optic interface ports. The tape drive node is assigned 
the first WWN of the block, and the next two WWNs, in sequence, are assigned to the 
ports.

Certain libraries override the default WWN with a library-assigned dynamic WWN 
(dWWN). Typically, only the last four characters differ from the default WWN. When 
dWWNs are active, (library) appears in the label.

You can also manually override the WWN with a custom WWN. In some 
circumstances, a service representative might customize a replacement tape drive’s 
WWN to be the same as the replaced, defective tape drive’s WWN. This precludes a 
requirement for a full system reset to acknowledge a new WWN.

If you apply a custom WWN to the tape drive node, you must also apply custom 
WWNs to the interface ports.

Interface Port Attributes  Port physical address attributes are only used when the tape 
drive is in an arbitrated-loop. The settings are not applicable when the tape drive is in 
an interface fabric.

There are two identical interface port attribute groups:

■ Pa = Port A

■ Pb = Port B

Hard-assigned Physical Address

■ Yes

The tape drive uses a specified hard physical address (PA).

■ No

The tape drive seeks a soft PA. This is the default.

Arbitrated Loop Address (loop ID)

This entry (0 - 125) specifies the loop ID when the Hard PA selection is Yes. 
Factory-preset defaults are: 0 for Port A, 1 for Port B.

Soft-assigned Physical Address (Hi/Lo)

Note: Soft PA is valid when the Hard PA selection is No.

■ Hi

The tape drive seeks an available loop ID in a descending order.

■ Lo

The tape drive seeks an available loop ID in a descending order. This is the default

Maximum Receive Size  
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complete the IPL. DO NOT select a size option other than 2112 or 
2048.
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The maximum receive (max recv) size value determines the maximum data frame size 
for data processing. There are two values:

■ 2112

■ 2048

212 is the factory setting. Do not change this value unless directed by your IT Manager 
or StorageTek support representative. The option defaults to the last saved selection.

World Wide Name Override  Each port has a unique WWN that you can override. See 
"World Wide Name" on page 10-13 for more information.

If you apply a custom WWN to the tape drive node, you must also apply custom 
WWNs to the interface ports. When a customized WWN is active, (custom) appears in 
the label.

Speed Negotiation  

Note: Do not change the speed setting unless directed by your IT 
manager or StorageTek Support.

The Speed Negotiation options depend on the capability of the interface transceiver 
present in the tape drive. The following options are available for a 4 Gbit tape drive:

■ Auto

■ 1GB

■ 2GB

■ 4GB

When you select Auto, the tape drive operates at the negotiated interface speed, which 
is typically determined by the slowest attached device. Auto is preset at the factory.

When you select a fixed rate, the tape drive only operates at the specified speed and 
might cause the tape drive to be unavailable, unless all other interface devices are set 
to the same speed.

File Sync Accel  The StorageTek File Sync Accelerator (FSA) allows applications to 
reduce or eliminate back hitches that are normally caused by writing a tape mark or 
other sync operations. Click the appropriate button to enable or disable the feature.

Tape App Accel  The StorageTek Tape Application Accelerator (TAA) avoids back hitches 
by converting tape marks to buffered tape marks and syncs to NO-OPs. The feature is 
only available with FICON. Click the appropriate button to enable or disable the 
feature.

This feature must only be used in environments that handle deferred errors. When this 
feature is enabled, sending a tape mark does not ensure that data has successfully been 
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written to the tape. A deferred error may be reported when buffered data is written to 
tape after the command has completed. In a FICON only environment, duplex write 
operations should use this feature.

Max Capacity  Maximum capacity allows the use of tape capacity that is normally 
reserved to ensure tape-to-tape copy operations succeed. Enabling this feature can 
increase cartridge capacity by five to ten percent.

Help Menu
To open the Help menu, click Help in the menu bar or use the ALT+H keyboard 
shortcut.

Note: Help menu commands are available when the tape drive is 
either online or offline.

The Help menu includes the following commands:

About

Displays a dialog box that provides the following information about the VOP 
application and environment.

■ Role level access

■ VOP Version

■ VOP Build Date

■ Drive Name (if a tape drive is connected)

■ Drive Type (if a tape drive is connected)

■ Java Version

■ License Agreement

Note: Optionally, you can use the SHIFT+A keyboard shortcut to 
issue this command from the Help menu. To close the dialog, click OK 
or use the ALT-O keyboard shortcut.

FSC Dictionary

Opens the FSC Look Up dialog box, used to perform a lookup in the Fault System 
Code (FSC) Dictionary

Note: The FSC Dictionary is available with or without a tape drive 
connection.

When the FSC Look Up dialog box appears, enter an FSC number, select the dictionary 
for the tape drive model, and click the LOOKUP button. The fault system code 
description is displayed in the VOP transcript pane. For example:

FSC: A33A |NO TAPE IS |LOADED | ***

MIM Code: NONE
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FRU: OPER. ERROR CONF: 100%

Field Text:
The user requested motion operation that requires a tape to be
installed, however, a tape has not been loaded.
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11Using LTO VOP 

This chapter describes how to use the LTO Virtual Operator Panel (VOP) with a single 
encryption-enabled HP or IBM Linear Tape Open (LTO) Ultrium LTO-4, LTO-5, or 
LTO-6 tape drive.

Designed for ease of use, the LTO VOP Graphical User Interface (GUI) enables you to 
do the following:

■ Monitor tape drive status

■ Monitor tape drive status

■ Perform tape drive service tasks

LTO VOP Interface
Figure 11–1 shows the LTO VOP main interface:
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Figure 11–1 LTO VOP Interface

Legend:

1. Title Bar (Includes Menus)

2. Connect Button

3. Tape Drive Status Indicators

4. Function Tabs

As shown in Figure 11–1, the LTO VOP interface includes the following:

■ Title Bar

Click the icon in the title bar to access a basic menu you can use to re-size the 
window and close the application.

■ Connect Button

Enter the IP address of your LTO tape drive in the accompanying field and click 
the Connect button.

■ Tape Drive Status Indicators

These indicators show the current drive state:

– The Online/Offline status indicator indicates whether the Ethernet adapter 
card is online. When you bring a tape drive online, this status indicator 
changes from gray to blue, and indicates Online.
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– The Empty/Loaded status indicator indicates whether a tape cartridge is 
loaded in the tape drive. When you load a cartridge in the tape drive, this 
status indicator changes from gray to blue, and indicates Loaded.

– The Service status indicator indicates whether the Ethernet card is 
communicating with the tape drive.

– The Encryption status indicator indicates whether the tape drive is enrolled 
for encryption.

Note: You can click directly on certain status indicators to toggle the 
state of the monitored tape drive item.

■ Function Tabs

These tabs provide functions used to configure, monitor, and service the tape 
drive. See "LTO VOP Function Tabs" on page 11-3 for more information.

During the course of selected operations, the message pane located on the Service 
Drive tab displays a transcript of LTO VOP actions and prompts for additional 
input.

Changing the Online/Offline Status of a Drive
Certain LTO VOP functions require the tape drive to be offline.

Changing Drive Status to Offline
Do the following:

1. Determine the current drive state.

View the Online/Offline status indicator. If the tape drive is online, proceed with 
the next step. If the tape drive is offline, stop.

2. Change the drive state to Offline using one of the following methods:

■ Click the first status indicator.

■ Click the Enroll Drive tab and then click the Set Offline button.

■ Click the Configure Drive tab and then click the Set Offline button.

3. Verify that the tape drive is offline.

The first Online/Offline status indicator is gray and is labeled Offline. In addition, 
the button in the Enroll Drive tab is labeled Set Online.

Error Messages
Depending on conditions, certain LTO VOP functions result in error conditions. For 
example, an error occurs if you attempt to place the tape drive (adapter card) offline 
while a tape cartridge is loaded.

LTO VOP Function Tabs
LTO VOP includes the following tabs used to perform various functions on the tape 
drive:
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■ Monitor Drive

■ Enroll Drive

■ Configure Drive

■ Service Drive

The following sections describe these function tabs.

Monitor Drive
Click this tab to display a list of tape drive, cartridge, and OKM agent attributes and 
values for those attributes. Some attributes require an additional action, such as tape 
drive enrollment for encryption, before the associated data appears.

Figure 11–2 shows an example of the Monitor Drive page:

Figure 11–2 LTO VOP Monitor Drive tab

As shown in Figure 11–2, this page lists the following tape drive attributes:

■ Drive Type

■ Drive ID

■ Media Type

■ MAC Address

■ IP Address

■ Netmask

■ Gateway

■ IPv6 Local Address

■ OKM Agent ID
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■ OKM IP Address

■ Adapter Card Firmware Version

■ Drive Firmware Version

■ OKM Agent Version

Enroll Drive

Note: Refer to your encryption documentation before using this 
page. The sequence for using the Configure Drive and Enroll Drive 
tabs is critical to success.

Click this tab to access functions used to specify enrollment settings and enroll the 
tape drive adapter card.

Figure 11–3 shows an example of the Enroll Drive page:

Figure 11–3 LTO VOP Enroll tab

As shown in Figure 11–3, this page includes fields to specify enrollment settings, and 
buttons to perform related operations.

To change a setting, enter a new value in a field. The accompanying Update check box 
is automatically selected to indicate a change.

Fields
The Enroll Drive page includes the following fields:

KMA Agent ID

The KMA agent defined in OKM.
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KMA IP Address

The KMA service network address.

Passphrase

The KMA agent passphrase defined in OKM.

Confirm Passphrase

Confirmation of the KMA agent passphrase.

Note: Before you enroll a tape drive, you must create the agent with 
the passphrase assigned in the OKM. The OKM must be able to 
communicate with the adapter card and tape drive.

Buttons
The Enroll Drive page includes the following buttons:

Set Offline

Click this button to set the tape drive offline.

The label on this button changes depending on the current drive state (for example, 
the label is Set Offline when the drive state is Online).

Commit

Click this button to save the enrollment settings in NVRAM. The Ethernet card does 
not reboot if you only change the enrollment settings.

When you click the Commit button, only those fields with an active check box are 
updated.

Enroll

After you commit your enrollment settings, click this button to enroll the drive.

Cancel

Click this button to cancel all pending setting changes.

Configure Drive

Note: Refer to your encryption documentation before using this 
page. The sequence for using the Configure Drive and Enroll Drive 
tabs is critical to success.

Click this tab to access functions used to specify IP settings for the tape drive. This 
page is typically used by the service representative to configure the tape drive to use 
settings other than those set during the manufacturing process.

Figure 11–4 shows an example of the Configure Drive page:
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Figure 11–4 LTO VOP Configure Drive tab

As shown in Figure 11–4, this page includes fields to specify IP settings, and buttons to 
perform related operations.

To change a setting, enter a new value in a field. The accompanying Update check box 
is automatically selected to indicate a change.

Fields
The Configure Drive page includes the following fields:

IP Address

Enter the IP address for the tape drive.

Netmask

Enter the Netmask for the tape drive.

Gateway

Enter the Gateway for the tape drive.

Buttons
The Configure Drive page includes the following buttons:

Set Offline

Click this button to set the tape drive (adapter card) offline.

The label on this button changes depending on the current drive state (for example, 
the label is Set Offline when the drive state is Online).

Commit

Click this button to save the IP settings in NVRAM. The Ethernet card reboots when 
you change an IP setting. When you click the Commit button, only those fields with an 
active check box are updated.
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Cancel

Click this button to unselect all pending setting changes.

Service Drive

Note: Refer to your encryption documentation before using this 
page.

Click this tab to access functions used to perform service functions on the tape drive. 
These functions are primarily intended for the service representative.

Figure 11–5 shows an example of the Service Drive page:

Figure 11–5 LTO VOP Service Drive tab

As shown in Figure 11–5, this page contains a text-based transcript area and the 
following buttons:

Support Logs

Saves log files to a specified location.

Clear Transcript

Erases the content displayed in the text pane.

IPL

Performs an Initial Program Load (IPL) of the Ethernet card.

RUN Loop Test

Performs an internal loopback test on the tape drive.

Load HP Firmware
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Starts the Ethernet card firmware update procedure. You are prompted to identify the 
directory that contains the Ethernet card firmware files.

IBM Bel Adapter

Click one of the following buttons to specify the IBM Bel Adapter code version:

■ Load 2.x Firmware (LDI only)

■ Load 4.x Firmware (ADI or LDI)

You must power cycle the drive after the adapter firmware update is complete.

Set IBM Bel Adapter Mode

This option is only available when running version 4.x of the Adapter firmware.

Click one of the following options to specify the IBM Bel Adapter mode:

■ ADI (Analog/Digital Interface)

■ LDI (Library/Drive Interface)

About

Displays LTO VOP version, basic tape drive information, and copyright information. 
For example:

Figure 11–6 LTO VOP About Dialog
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12Using 9XXX VOP 

This chapter describes how to use the 9XXX Virtual Operator Panel (VOP) with a 
single T9840B, T9840C, T9940A, or T9940B tape drive.

Designed for ease of use, the 9XXX VOP Graphical User Interface (GUI) enables you to 
do the following:

■ Monitor tape drive status

■ View or change tape drive configuration settings

■ Perform tape drive operation utilities

9XXX VOP Interface
Figure 12–1 shows the 9XXX VOP main interface:

Figure 12–1 9XXX VOP Interface

Legend:

1. Menus

2. Drive IP

3. Menu and Select Switches

4. Primary and Secondary Message Windows

5. Status Indicators

6. Transcript Pane
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As shown in Figure 12–1, the 9XXX VOP interface includes the following:

■ Menus

Use menus to issue 9XXX VOP commands. See "Using 9XXX VOP Menus" on 
page 12-2 for more information.

■ Drive IP

Displays the IP address of the tape drive loaded.

■ Menu/Select Switches

Use these switches to access the tape drive menu system. See "Using Menu and 
Select Switches" on page 12-6 for more information.

■ Tape Drive Status Indicators

These indicators show the current drive state:

– The Empty/Loaded status indicator indicates whether a tape cartridge is 
loaded in the tape drive. When you load a cartridge in the tape drive, this 
status indicator changes from gray to blue, and indicates Loaded.

– The Online/Offline status indicator indicates whether the Ethernet adapter 
card is online. When you bring a tape drive online, this status indicator 
changes from gray to blue, and indicates Online.

– The Clean status indicator indicates that the tape drive must be cleaned.

– The Dump status indicator indicates that a dump is present for retrieval.

■ Primary and Secondary Message Windows

Display status messages during 9XXX VOP processing.

■ Transcript Pane

Displays a transcript of 9XXX VOP actions and prompts for additional input or 
actions.

Using 9XXX VOP Menus
9XXX VOP includes the following menus:

■ File Menu

■ Drive Operations Menu

■ Retrieve Menu

■ Configure Menu

■ Help Menu

Note: Certain menus require the tape drive to be offline.

File Menu
File menu commands are available when the tape drive is either online or offline. The 
File menu includes the following commands:

Clear Transcript
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Clears the entire 9XXX VOP transcript pane and closes the file menu.

Connect to Drive

Connects 9XXX VOP to the tape drive. When the authentication dialog box appears, 
enter the tape drive IP address and click OK.

Note: Optionally, you can use the SHIFT+C keyboard shortcut from 
the File menu to issue this command.

Display 9XXX Logs from File

Displays tape drive logs from a specified file.

Exit

Disconnects 9XXX VOP from the tape drive and closes the application. Allow a few 
seconds for the shutdown operation to complete.

Drive Operations Menu
To open the Drive Operations menu, click Drive Operations in the menu bar or use 
the ALT+D keyboard shortcut.

Refer to the T9x40 Tape Drive User’s Reference Manual for additional information 
regarding the tape drive, use of a cartridge tape, and general operating procedures.

The Drive Operations menu includes the following commands:

Note: The tape drive must be encryption-enabled for some 
commands to appear.

Unload Tape

Rewinds and unloads a loaded cartridge. A text pane message indicates that the tape 
cartridge is unloaded.

You must physically remove an unloaded cartridge from the tape drive by library 
robotics, or manually, from the rack mount configuration. Otherwise, the cartridge 
remains in the loading slot but is not loaded in the tape drive.

Note: Optionally, you can use the SHIFT+U keyboard shortcut to 
issue this command from the Drive Operations menu.

IPL Drive

Performs a tape drive initial program load (IPL).

If the tape drive is online, a confirmation dialog box appears. During the IPL, VOP 
loses communication with the tape drive. Once the IPL is successfully completed, VOP 
automatically reconnects with the tape drive.

Force Dump

Dumps the current contents of various drive registers to a file.

The tape drive stores the dump to internal memory, and the dump status indicator 
changes to orange. The forced dump operation causes a tape drive IPL, during which 
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VOP loses connection with the tape drive. Once the IPL is successfully completed, 
FFFA appears in the secondary drive message window.

Retrieve Menu
To open the Retrieve menu, click Retrieve in the menu bar or use the ALT+R keyboard 
shortcut.

The Retrieve menu includes the following commands:

Dumps to File

Retrieves diagnostic dumps that are currently stored in the drive memory, and enables 
you to save the dumps in a specified location. After you save the dump file, an entry is 
displayed in the VOP transcript pane. For example:

8:55 AM Aug 2, 2010 - DUMP AVAILABLE: fffa:Dmp 1

8:55 AM Aug 2, 2010 - DUMP AVAILABLE: fffa:DMP 1

9:00 AM Aug 2, 2010 - Retrieve Dumps in Progress

9:00 AM Aug 2, 2010 - Dumps RETRIEVED to D:\T9840B_dump_aug2

Logs to File

Retrieves event logs that are currently stored in the tape drive memory, and enables 
you to save the event logs in a specified location.

Perms to File

Retrieves all the permanent errors that are currently stored in the tape drive memory, 
and enables you to save the error log in a specified location.

Retrieves a log containing non-dump events.

Get and Display Logs

Retrieves and displays event logs that are currently stored in the tape drive memory.

Delete Dumps

Deletes all diagnostic dumps from the tape drive.

Delete Logs

Deletes all event logs from the tape drive.

Delete Perms

Deletes all permanent errors from the tape drive.

Note: It is recommended that you save logs before deleting them, as 
they can help in troubleshooting tape drive issues.

Configure Menu
With the exception of the Set Clock command, these commands are only available 
when the tape drive is offline. The tape drive should not be available to the host when 
you exercise any change that results in the tape drive performing an Initial Program 
Load (IPL) to implement the configuration change.

The Configure menu includes the following commands:

Set Clock
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Sets the tape drive’s internal clock to the current time in your computer. Once the clock 
is set, an entry is displayed in the VOP transcript pane.

Code Load from File

Loads firmware from a user-specified file to a tape drive. See "File Menu" on page 12-2 
for more information.

Loading Drive Firmware
Use 9XXX VOP menus, 9XXX VOP controls, and the tape drive menu system to load 
drive firmware.

1. From the 9XXX interface, click the Menu button to enter the tape drive menu 
system.

The primary message window displays Online, and the status indicator is blue.

2. Click the Select button to place the tape drive in an Offline state.

The primary message window displays Offline, and the status indicator changes 
to gray.

3. Click the Configure menu and select Code Load from File.

The Open dialog box appears.

4. Locate the firmware file and click the Open button.

The 9XXX transcript pane displays START Code Load from File. As the process 
continues, the transcript displays additional messages regarding the code load, 
IPL, and re-connection to 9XXX VOP.

Note: The code load process may take several minutes

5. Click the Menu button to display the code version in the primary message 
window.

6. Use the Menu and Select buttons to exit the drive menu system.

7. Click the File menu and select Exit.

8. Disconnect the crossover Ethernet cable from the tape drive Ethernet port.

9. Set your PC to obtain an IP address automatically.

Help Menu
To open the Help menu, click Help in the menu bar or use the ALT+H keyboard 
shortcut. Help menu commands are available when the tape drive is either online or 
offline.

The Help menu includes the following commands:

About

Displays a dialog box that provides the following information about the 9XXX 
application and environment.

■ Role level access

■ VOP Version (single tape drive application)

■ VOP Build Date (single tape drive application)
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■ Drive Name (if a tape drive is connected)

■ Drive Type (if a tape drive is connected)

■ Java Version

■ License Agreement

Note: Optionally, you can use the SHIFT+A keyboard shortcut to 
issue this command from the Help menu. To close the dialog, click OK 
or use the ALT-O keyboard shortcut.

FSC Dictionary

Opens the FSC Look Up dialog box, used to perform a lookup in the Fault System 
Code (FSC) Dictionary. The FSC Dictionary is available with or without a tape drive 
connection.

When the FSC Look Up dialog box appears, enter an FSC number, select the dictionary 
for the tape drive model, and click the LOOKUP button. The fault system code 
description is displayed in the VOP transcript pane. For example:

FSC: A33A  |NO TAPE IS       |LOADED              | ***

MIM Code:  NONE

FRU:        OPER.  ERROR CONF:  100%

Field Text:

The user requested motion operation that requires a tape to be installed, 
however, a tape has not been loaded.

Using Menu and Select Switches
The portion on the 9XXX interface between the menu bar and transcript pane contains 
elements designed to mimic the physical operator panel on a 9x40 tape drive.

Use the Menu and Select buttons to access the tape drive’s menu system.

It is assumed that you fully understand the tape drive menu system. Refer to the 
T9x40 Tape Drive Service Reference Manual for a detailed description of the drive menu 
system.

Menu Button
Click the Menu button to enter the drive menu system or advance to the next portion 
of the drive menu system. Menu options and values display in the primary message 
window.

Figure 12–2 shows an example:
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Figure 12–2 9XXX VOP Menu Switch

As shown in Figure 12–2, the Menu button has been clicked several times and View 
CFG? appears in the primary message window.

Select Button
Click the Select button to advance to the next available menu option or value, to enter 
a submenu (such as View CFG?), or to exit from either a submenu or the main menu 
system.

Figure 12–3 shows an example:

Figure 12–3 9XXX VOP Select Switch

As shown in Figure 12–3, the Select button has been clicked, resulting in an exit from 
the main menu system. An asterisk (*) appears in the primary message window.
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Changing the Default MD-VOP User File Directory A-1

AChanging the Default MD-VOP User File 
Directory

By default, MD-VOP stores user created files under the User home directory, in a 
subdirectory called .mdvop.

You can edit the MD-VOP launch scripts as follows to override the default home 
directory where the .mdvop directory resides.

Changing the Default Directory in Windows
Access the MD-VOP executable file, mdvop.bat, in a text editor and insert the 
following statement in both entries:

-Dapplication.user.home=<new root path>

Note: Substitute your new directory path for new root path.

In the following example, the inserted statements are shown in bold:

start %javalocation% -classpath %classpatha% -

Dapplication.user.home=<new root path> -

Djava.security.policy=rmi.policya %policya% -view

start %javalocation% -classpath %classpatha% -

Dapplication.user.home=<new root path> -

Djava.security.policy=rmi.policya %policya% -view %1

Changing the Default Directory in UNIX
Access the MD-VOP executable file, mdvop, in a text editor and insert the following 
statement in the first two entries:

-Dapplication.user.home=<new root path>

Note: Substitute your new directory path for new root path.

In the following example, the inserted statements are shown in bold:

${javalocation} -classpath "${startlib}" -
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Dapplication.user.home=<new root path> -

Djava.security.policy=${policycurrent} -cse

${javalocation} -classpath "${startlib}" -

Dapplication.user.home=<new root path> -

Djava.security.policy=${policycurrent} -cse ${properties} &

Note: You do not need to edit the third entry.
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Glossary

Some definitions in this glossary are taken from other glossaries. For these definitions, 
the source of the definition is indicated by letters in parentheses, following the 
definition:

(A) The American National Standard Dictionary of Information Systems, ANSI 
X3.172-1990, copyright 1990 by the American National Standards Institute (ANSI).

(E) The ANSI/Electronic Industries Association (EIA) Standard-440-A, Fiber Optic 
Terminology.

(I) The Information Technology Vocabulary, developed by Subcommittee 1, Joint 
Technical Committee 1, of the International Organization for Standardization and 
International Electrotechnical Commission (ISO/IEC/JTC1/SC1).

(IBM) The IBM Dictionary of Computing, copyright 1994 by IBM.

(T) Draft international standards committee drafts, and working papers being 
developed by the ISO/IEC/JTC1/SC1.

address

A character or group of characters that identifies a register, a particular part of storage, 
or some other data source or destination. (A).

alphanumeric

A character or group of characters that identifies a register, a particular part of storage, 
or some other data source or destination. (A).

capacity

Total amount of User Data stored on one data cartridge in 8 bit bytes. Synonymous 
with “User Capacity” or “Native Capacity”. This is the capacity that the user sees after 
the ECC/Format/ERP etc. overhead has been assessed (no compression).

capacity, raw

Total amount of data stored on one data cartridge in 8 bit bytes before any 
ECC/Format/ERP etc. overhead has been assessed (no compression).

capacity, user

Total amount of data stored on one data cartridge in 8 bit bytes that is sent by the host 
computer. This is the capacity that the user sees after the ECC/Format/ERP etc. 
overhead has been assessed (no compression).
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cartridge

A storage device that consists of magnetic tape on supply and takeup reels, in a 
protective housing. (IBM)

cleaning cartridge

A data cartridge that contains special material to clean the tape path in a transport or 
drive.

compress

To save space by eliminating gaps, empty fields, redundancy, or unnecessary data to 
shorten the length of records or files. (IBM)

configuration

The manner in which the hardware and software of an information processing system 
is organized and interconnected. (T)

connector

An electrical or optical part that joins two or more other parts.

data cartridge

A container holding magnetic tape that can be processed without separating the tape 
from the container.

data path key management (DPKM)

See DPKM.

data security erase (DSE)

See DSE.

data tape

A data cartridge formatted for use as a regular data tape for the system in which it is 
used.

data track(s)

The region(s) of recorded tape containing user data formed as discreet longitudinal 
“tracks” (similar to railroad tracks).

diagnostics

Pertaining to the detection and isolation of errors in programs and faults in 
equipment. (IBM)

DPKM

data path key management. The use of the SCSI 4 commands Security Protocol In and 
Security Protocol Out to implement host-based key management encryption on 
StorageTek tape drives.

drive

A device for moving magnetic tape and controlling its movement. (IBM)

DSE

data security erase. A random binary pattern, over-writing existing data, from the 
point of an Erase command, to the end-of-tape.
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dump

To copy the contents of all or part of virtual storage to collect error information. (IBM)

emulation

The use of programming techniques and special machine features to permit a 
computing system to execute programs written for another system. (IBM)

encryption

The translation of data into a secret code. Encryption is one of the most effective ways 
to achieve data security. To read an encrypted file, you must have access to a special 
key or password that enables you to decipher it.

EOT

End of Tape.

erase

To remove data from a data medium, leaving the medium available for recording new 
data. (I) (A)

error

A discrepancy between a computed, observed, or measured value or condition and the 
true, specified, or theoretically correct value or condition. (I) (A)

ESD

Electrostatic Discharge.

fault symptom code (FSC)

See FSC.

FC

fibre channel. The National Committee for Information Technology Standards 
standard that defines an ultrahigh-speed, content-independent, multilevel data 
transmission interface that supports multiple protocols simultaneously. Fibre Channel 
supports connectivity to millions of devices over copper and/or fiber-optic physical 
media and provides the best characteristics of both networks and channels over 
diverse topologies.

fiber channel (FC)

See FC.

fiber optics

The branch of optical technology concerned with the transmission of radiant power 
through fibers made of transparent materials such as glass, fused silica, and plastic. (E)

fiber-optic cable

A cable made of ultrathin glass or silica fibers which can transmit data using pulses of 
laser light. Fiber-optic cables have several advantages over copper cables: they have 
much less signal loss; they allow information to be transmitted at higher speeds and 
over longer distances; they are not affected by external electrical noise; and they are 
better for transmissions which require security.
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fibre channel

The National Committee for Information Technology Standards standard that defines 
an ultrahigh-speed, content-independent, multilevel data transmission interface that 
supports multiple protocols simultaneously. Fibre Channel supports connectivity to 
millions of devices over copper and/or fiber-optic physical media and provides the 
best characteristics of both networks and channels over diverse topologies.

fibre connection (FICON)

See FICON.

FICON

fibre connection. An ESA/390 and zSeries computer peripheral interface. The I/O 
interface uses ESA/390 and zSeries FICON protocols (FC-FS and FC-SB-2) over a Fibre 
Channel serial interface that configures units attached to a FICON-supported Fibre 
Channel communications fabric..

FICON channel

A channel having a Fibre Channel connection (FICON) channel-to-control-unit I/O 
interface that uses optical cables as a transmission medium.

file-protect

To prevent the erasure or overwriting of data stored on data cartridges.

FIPS

Federal Information Processing Standards.

FRU

Field Replaceable Unit.

FSC

Fault Symptom Code. A four-character hexadecimal code generated in response to an 
error to help isolate failures within the device.

FTP

Generic definition: File Transfer Protocol.

GB

One billion (109) bytes..

Gb

Gigabit, equal to 109 bits.

Gbps

Gigabits per second.

gigabyte (GB)

See GB.

hardware

All or part of the physical components of an information processing system, such as 
computers or peripheral devices. (T) (A)
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hub

A Fibre Channel Arbitrated Loop switching device that allows multiple servers and 
targets, such as storage systems, to connect at a central point. A single hub 
configuration appears as a single loop.

indicator

A device that provides a visual or other indication of the existence of a defined state. 
(T)

interface

Hardware, software, or both, that links systems, programs, or devices. (IBM)

internet protocol (IP)

See IP.

internet protocol (IP) address

A four-byte value that identifies a device and makes it accessible through a network. 
The format of an IP address is a 32-bit numeric address written as four numbers 
separated by periods. Each number can be from 0 to 255. For example, 129.80.145.23 
could be an IP address.

IP

internet protocol. A protocol used to route data from its source to its destination in an 
Internet environment. (IBM)

internet protocol v4 (IPv4) address

A four-byte value that identifies a device and makes it accessible through a network. 
The format of an IP address is a 32-bit numeric address written as four numbers 
separated by periods. Each number can be from 0 to 255. For example, 129.80.145.23 
could be an IP address.

internet protocol v6 (IPv6) address

The next generation internet protocol. It provides a much larger address space than 
IPv4. This is based upon the definition of a 128-bit address - IPv4 used a 32-bit 
address. The IPv6 address format is eight fields of four hexadecimal characters 
separated by colons (for example, 2001:0db8:85a3:0000:0000:8a2e:037 0:7334).

library

A robotic system that stores, moves, mounts, and dismounts data cartridges that are 
used in data read or write operations.

Linear Tape-Open

A set of data format standards created to enable data interchange among tape drive 
produced by a consortium of manufacturers. With LTO standards, the tape cartridges 
are interchangeable among tape drive brands.

link

A physical connection (electrical or optical) between two nodes of a network.

magnetic tape

A tape with a magnetizable layer on which data can be stored. (T)
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menu

A list of options displayed to the user by a data processing system, from which the 
user can select an action to be initiated. (T)

network

An arrangement of nodes and branches that connects data processing devices to one 
another through software and hardware links to facilitate information interchange.

offline

Neither controlled by, nor communicating with, a computer. (IBM)

For a tape drive, this indicates that the tape drive is communicating, but 
reading/writing of data cannot be sent.

online

Pertaining to the operation of a functional unit when under the direct control of the 
computer. (T)

For a tape drive, this indicates that the tape drive is communicating and all data can be 
sent.

performance

One of two major factors, together with facility, on which the total productivity of a 
system depends. Performance is largely determined by a combination of throughput, 
response time, and availability. (IBM)

read/write head

The data sensing and recording unit of a diskette magazine drive or tape drive. (IBM)

release

A distribution of a new product or new function and fixes for an existing product. 
(IBM)

R/W

Read/Write.

SDP

Service Delivery Platform.

submenu

A menu related to and reached from a main menu. (IBM)

subsystem

A system that is part of some larger system.

switch

In Fibre Channel technology, a device that connects Fibre Channel devices together in 
a fabric.

system

A combination of functionally interrelated interacting mechanical and electrical 
elements designed to work as a coherent entity.
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T10000 Tape Drive (VOP)

A software application that allows a user to monitor and perform some operations on 
a tape drive.

tape

See magnetic tape.

tape cartridge

A container holding magnetic tape that can be processed without separating the tape 
from the container.

tape drive

A device for moving magnetic tape and controlling its movement. (T)

TCP/IP

Transmission Control Protocol/Internet Protocol. A set of communication protocols 
that support peer-to-peer connectivity functions for both local and wide area 
networks. (IBM)

transmission control protocol/internet protocol (TCP/IP)

See TCP/IP.

Ultrium

An LTO tape format optimized for high capacity and performance with outstanding 
reliability. The Ultrium tape format uses a single reel cartridge to maximize capacity.

VOLSER

volume serial number. An alphanumeric label that the host software uses to identify a 
volume. It attaches to the spine of a cartridge and is both human- and 
machine-readable. It is, usually 6 characters long and is both the paper label stuck on 
the back edge of the cartridge and in the VOLID label that is recorded, particularly by 
MVS systems, at the beginning of the media.

volume serial number (VOLSER)

See VOLSER.

wrap

A single pass of tape from either BOT to EOT or EOT to BOT with the head(s) in a 
fixed transverse location.

write-enabled

A setting on a data cartridge that allows data to be written on the tape.

write-protected

A setting on data cartridges that prevents data from being written on the tape. 
Reading data is still possible.
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Index

Numerics
9XXX VOP

drive support, 3-5
interface, 12-1
menu and select switches, 12-2
menus, 12-2
overview, 12-1

A
About command

9XXX VOP, 12-5
LTO VOP, 11-9
MD-VOP, 8-2
T10000 9840D VOP, 10-16

ASR
Activate tab, 7-18
Creation tab, 7-18
Log tab, 7-19
Register tab, 7-17
Report command, 9-9
Test tab, 7-19
view, MD-VOP, 7-15

C
Cancel button, Configure Drive Parameters 

dialog, 10-11
certificate files, retrieving from OKM, 9-8
Clear all Drive Transcripts command, 9-1
Clear Library Transcript command, 9-1
Clear Spreadsheet command, 8-9
Clear Transcript command, 10-3

9XXX VOP, 12-2
client system requirements, 3-1
Code Load from File command, 12-5
Collect Support Logs command, 10-3
commands

9XXX VOP
About, 12-5
Clear Transcript, 12-2
Code Load from File, 12-5
Connect to Drive, 12-3
Delete Dumps, 12-4
Delete Logs, 12-4

Delete Parms, 12-4
Display 9XXX Logs from File, 12-3
Dumps to File, 12-4
Exit, 12-3
Force Dump, 12-3
FSC Dictionary, 12-6
Get and Display Logs, 12-4
IPL Drive, 12-3
Logs to File, 12-4
Perms to File, 12-4
Set Clock, 12-4
Unload Tape, 12-3

LTO VOP
About, 11-9

MD-VOP
About, 8-2
ASR Report, 9-9
Clear all Drive Transcripts, 9-1
Clear Library transcript, 9-1
Clear Spreadsheet, 8-9
Compare OKM, Spreadsheet, and Drives in 

This Library, 9-7
Connect to Server, 8-14
Contact Support, 8-2
Create Client Configuration File from 

Server, 8-14
Create OKM Agents in the Library, 9-6
Create Spreadsheet Template, 9-7
Create Spreadsheet Template with Agent 

Lookup, 9-7
Delete All Logs in This Library, 9-3
Delete Client Configuration File on 

Server, 8-17
Delete Configuration File, 8-8
Delete Dump Logs in This Library, 9-3
Delete Event Logs in This Library, 9-3
Delete Perm Logs in This Library, 9-3
Drive Status Report, 9-9
Edit Client Configuration File on Server, 8-15
Edit Configuration, 8-1
Edit Domain Configuration File on 

Server, 8-16
Edit Library Probe Configuration, 8-1
Encryption Report, 9-9
Enroll Drives in This Library, 9-6
Exit, 8-2
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Exit Configuration Dialog, 8-8
Firmware Update from File in This 

Library, 9-3
Get MDVOP Logs for Support, 8-2
Health Analysis of Selected Drives in This 

Library, 9-2
Health Report, 9-9
IPL Selected Drives in This Library, 9-2
Launch, 8-2, 8-8
Launch Client Configuration, 8-17
Launch Configuration, 8-1
License Drives in This Library, 9-7
Load Tape Cartridges in This Library, 9-2
MDVOP Default Settings, 8-2
MD-VOP Server, 8-1
Modify OKM Agents in the Library, 9-6
New Configuration, 8-8
Open Configuration, 8-8
Probe Complex, 8-8
Probe IP Addresses in Spreadsheet, 8-8
Probe IP Range for Drives, 8-8
Probe Library for Drives, 8-8
Reconnect to Selected Drives in This 

Library, 9-1
Reconnect to Unconnected Drives, 9-1
Refresh Icons in the Library, 9-1
Reset Probe Settings for this Library, 8-9
Retrieve All Logs in This Library, 9-3
Retrieve Dump Logs in This Library, 9-3
Retrieve Event Logs in This Library, 9-3
Retrieve ID Files in This Library, 9-2
Retrieve Library SN, 8-9
Retrieve Perm Logs in This Library, 9-3
Save, 8-8
Save as, 8-8
Scan Tray Serial Numbers, 8-9
Set as Default Configuration, 8-8
Set as Default Configuration File, 8-1
Set Clocks in This Library, 9-3
Set Drives to Unencrypting in This 

Library, 9-7
Set Selected Drives Offline in This Library, 9-2
Set Selected Drives Online in This Library, 9-2
Unenroll Drives in This Library, 9-6
Unload Tape Cartridges in This Library, 9-2
Unset Default Configuration, 8-8

T10000 9840D VOP
About, 10-16
Clear Transcript, 10-3
Collect Support Logs, 10-3
Connect Drive, 10-3
Drive Data, 10-9
Exit, 10-3
Firmware Update from File, 10-9
Firmware Update from Tape, 10-9
Force Dump, 10-4
Format Tape, 10-4
FSC Dictionary, 10-16
Identify Drive On, 10-4
Identify Drives Off, 10-5

IPL Drive, 10-4
Load Tape, 10-3
Save Drive Config, 10-9
Set Clock, 10-9
Set Offline, 10-4
Set Online, 10-4
Set Power Active, 10-5
Set Power Hibernate, 10-5
Unload Tape, 10-4
View Drive Data, 10-7

Commit button, Configure Drive Parameters 
dialog, 10-11

Compare OKM, Spreadsheet, and Drives in This 
Library command, 9-7

Configuration menu, MD-VOP, 9-3
Configure Drive function tab, LTO VOP, 11-6
Configure menu

9XXX VOP, 12-4
T10000 9840D VOP, 10-8

Connect Drive command, 10-3
Connect to Drive command

9XXX VOP, 12-3
Connect to Server command, 8-14
considerations

configuration, 3-5
VOP client/server, 5-7

Contact Support command, 8-2
Create Client Configuration File from Server 

command, 8-14
Create OKM Agents in the Library command, 9-6
Create Spreadsheet Template command, 9-7
Create Spreadsheet Template with Agent Lookup 

command, 9-7

D
dashboard, MD-VOP, 7-2
data file, OKM, 9-7
default settings, MD-VOP

Drive Health Display Settings, 8-21
Drive State Display Settings, 8-18
Encryption Display Settings, 8-20
Misc Display Settings, 8-18

Delete All Logs in This Library command, 9-3
Delete Client Configuration File on Server, 8-17
Delete Configuration File command, 8-8
Delete Dump Logs in This Library command, 9-3
Delete Dumps command

9XXX VOP, 12-4
Delete Event Logs in This Library command, 9-3
Delete Logs command

9XXX VOP, 12-4
Delete Perm Logs in This Library command, 9-3
Delete Perms command

9XXX VOP, 12-4
Display 9XXX Logs from File command, 12-3
Drive Data command, 10-9
drive data settings, Configure Drive Parameters 

dialog, 10-12
drive firmware, loading, 12-5
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Drive Operations menu
9XXX VOP, 12-3
MD-VOP, 9-2
T10000 9840D VOP, 10-3

drive requirements, 3-3
Drive Status Report command, 9-9
drive support

9XXX VOP, 3-5
LTO VOP, 3-4
MD-VOP, 3-3
T10000 9840D, 3-4

drive views, MD-VOP
ASR view, 7-15
Drive Health view, 7-12
Drive State view, 7-9
Encryption view, 7-10
SDVOP view, 7-14
Transcript view, 7-14

Dumps to File command, 12-4

E
Edit Client Configuration File on Server, 8-15
Edit Configuration command, 8-1
Edit Domain Configuration File on Server, 8-16
Edit Library Probe Configuration command, 8-1
Encrypt tab, Configure Drive Parameters 

dialog, 10-10
Encryption

default display settings, 8-20
menu, MD-VOP, 9-6
Report command, 9-9
view, MD-VOP, 7-10

Enroll Drive function tab, LTO VOP, 11-5
Enroll Drives in This Library command, 9-6
Ethernet connection, 3-5
Exit command

9XXX VOP, 12-3
MD-VOP, 8-2
T10000 9840D VOP, 10-3

Exit Configuration Dialog command, 8-8

F
Fibre tab, Configure Drive Parameters dialog, 10-10
File menu

9XXX VOP, 12-2
MD-VOP, 8-1
MD-VOP Library Panel, 9-1
T10000 9840D VOP, 10-3

file permissions, Windows 7, 4-5
Firmware Update from File command, 10-9
Firmware Update from File in This Library 

command, 9-3
Firmware Update from Tape command, 10-9
firmware update, performing, 9-3
Force Dump command

9XXX VOP, 12-3
T10000 9840D VOP, 10-4

Format Tape command, 10-4

FSC Dictionary command
9XXX VOP, 12-6
T10000 9840D VOP, 10-16

G
Get and Display Logs command

9XXX VOP, 12-4
Get MDVOP Logs for Support command, 8-2

H
Health Analysis of Selected Drives in This Library 

command, 9-2
Health Report command, 9-9
Help menu

9XXX VOP, 6-3, 12-5
MD-VOP, 8-2
T10000 9840D VOP, 10-16

I
Identify Drive On command, 10-4
Identify Drives Off command, 10-5
installation

default file directories, 4-1
installing VOP, 4-2
un-installing VOP, 4-6

interface
9XXX VOP, 12-1
LTO VOP, 11-1
MD-VOP, 7-1
T10000 9840D VOP, 10-1

IPL Drive command, 10-4, 12-3
IPL Selected Drives in This Library command, 9-2

J
Java requirement, 3-2

L
Launch Client Configuration, 8-17
Launch command, 8-2, 8-8
Launch Configuration command, 8-1
library panel, MD-VOP, 7-4
Library Probe Operations menu, 8-8
library requirements, 3-3
library support, MD-VOP, 3-3
Library Utilities menu, 8-9
License Drives in This Library command, 9-7
Load Drive Config button, Configure Drive 

Parameters dialog, 10-11
Load Tape Cartridges in This Library command, 9-2
Load Tape command, 10-3
Logs to File command, 12-4
LTO VOP

drive support, 3-4
interface, 11-1
overview, 11-1
starting, 6-2
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M
MD-VOP

dashboard, 7-2
default settings, changing, 8-17
drive support, 3-3
drive views

ASR view, 7-15
Drive Health view, 7-12
Drive State view, 7-9
Encryption view, 7-10
SDVOP view, 7-14
Transcript view, 7-14

interface, 7-1
library panel, 7-4
library panel menus, 9-1, 9-2
library support, 3-3
overview, 7-1
placeholder drive support, 3-4
starting, 6-1

MDVOP Default Settings command, 8-2
MD-VOP Server command, 8-1
MDVOP Server menu, 8-14
Menu switch, 9XXX VOP, 12-6
menus

9XXX VOP
Configure, 12-4
Drive Operations, 12-3
File, 12-2
Help, 6-3, 12-5
Retrieve, 12-4

MD-VOP
Configuration, 9-3
Drive Operations, 9-2
Encryption, 9-6
File, 8-1, 9-1
Help, 8-2
Library Probe Operations, 8-8
Library Utilities, 8-9
Reports, 9-9
Retrieve, 9-2
Server, 8-14

T10000 9840D VOP
Configure, 10-8
Drive Operations, 10-3
File, 10-3
Help, 10-16
Retrieve, 10-7

Modify OKM Agents in the Library command, 9-6
Monitor Drive function tab, LTO VOP, 11-4
My Oracle Support (MOS), 2-2

N
Network tab, Configure Drive Parameters 

dialog, 10-10
New Configuration command, 8-8

O
obtaining VOP, 2-1

My Oracle Support (MOS), 2-2
Oracle Software Delivery Cloud, 2-1

OKM
data file, 9-7
retrieving certificate files, 9-8

Open Configuration command, 8-8
Oracle software Delivery Cloud, 2-1
overview

9XXX VOP, 12-1
LTO VOP, 11-1
MD-VOP, 7-1
T10000 9840D VOP, 10-1
VOP client/server configuration, 5-1

P
permissions, Windows 7, 4-5
Perms to File command

9XXX VOP, 12-4
Power tab, Configure Drive Parameters 

dialog, 10-10
Probe Complex command, 8-8
Probe IP Addresses in Spreadsheet command, 8-8
Probe IP Range for Drives command, 8-8
Probe Library for Drives command, 8-8
probes

detect and place drive manually, 8-11
place by drive library location, 8-13
probing a complex, 8-10
probing an IP range for drives, 8-11
sequential IP drive placement, 8-13

R
Reconnect to Selected Drives in This Library 

command, 9-1
Reconnect to Unconnected Drives command, 9-1
Refresh Icons in the Library command, 9-1
Reports menu, MD-VOP, 9-9
requirements

client, 3-1
Java, 3-2
library and tape drive, 3-3
MD-VOP placeholder drive support, 3-4
server, 3-2
system, 3-1
tape drive, 3-3

Reset Probe Settings for this Library command, 8-9
Retrieve All Logs in This Library command, 9-3
Retrieve Dump Logs in This Library command, 9-3
Retrieve Event Logs in This Library command, 9-3
Retrieve ID Files in This Library command, 9-2
Retrieve Library SN command, 8-9
Retrieve menu

9XXX VOP, 12-4
MD-VOP, 9-2
T10000 9840D VOP, 10-7

Retrieve Perm Logs in This Library command, 9-3
roles, user, 3-1
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S
Save as command, 8-8
Save command, 8-8
Save Drive Config command, 10-9
Scan Tray Serial Numbers command, 8-9
Security tab, Configure Drive Parameters 

dialog, 10-11
Select switch, 9XXX VOP, 12-7
server system requirements, 3-2
Service Drive function tab, LTO VOP, 11-8
service network, 3-5
Set as Default Configuration command, 8-8
Set as Default Configuration File command, 8-1
Set Clock command, 10-9

9XXX VOP, 12-4
Set Clocks in This Library command, 9-3
Set Drives to Unencrypting in This Library 

command, 9-7
Set Offline command, 10-4
Set Online command, 10-4
Set Power Active command, 10-5
Set Power Hibernate command, 10-5
Set Selected Drives Offline in This Library 

command, 9-2
Set Selected Drives Online in This Library 

command, 9-2
starting

LTO VOP, 6-2
MD-VOP, 6-1
T10000 9840D VOP, 6-2

system requirements, 3-1

T
T10000 9840D VOP

drive support, 3-4
interface, 10-1
overview, 10-1
starting, 6-2

tape drive requirements, 3-3
transcript, MD-VOP, 7-14

U
Unenroll Drives in This Library command, 9-6
Unload Tape Cartridges in This Library 

command, 9-2
Unload Tape command, 10-4

9XXX VOP, 12-3
Unset Default Configuration command, 8-8
user roles, 3-1

V
View Drive Data command, 10-7
VOP

obtaining, 2-1
user roles, 3-1
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